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Preface

Preface

Audience

The purpose of this document is to provide you with an overview of the possibilities
offered by SAP BW Knowledge Modules and how to use them in Oracle Data
Integrator.

This document provides examples to help you understand how to approach an ETL
project with Oracle Data Integrator, loading a Data Warehouse with data from SAP BW
systems, while validating data quality.

This project should take approximately 90 minutes to complete. You may save your
work in order to pause and resume at any point in the project.

It is recommended that you use Oracle Data Integrator before proceeding with this
guide. A good introduction to Oracle Data Integrator is the guide Data Integrator
Getting Started.

It is recommended that you also review the SAP ABAP - BW chapter of Application
Adapters Guide for Oracle Data Integrator for more information about the SAP BW
KMs.

This document is intended for developers and administrators who want to use Oracle
Data Integrator Application Adapters with SAP BW systems using SAP JCo libraries,
as a development tool for their integration processes.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at ht t p: // www. or acl e. cont pl s/ t opi ¢/ | ookup?
ct x=accé& d=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit htt p: // ww. or acl e. coni pl s/ t opi ¢/

| ookup?ct x=acc&i d=i nfo or visit htt p://ww. or acl e. com pl s/t opi ¢/ | ookup?ct x=acc& d=trs
if you are hearing impaired.

Related Documents

ORACLE

For more information, see the following documents in Oracle Data Integrator Library.

* Release Notes for Oracle Data Integrator

» Understanding Oracle Data Integrator
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Conventions

The following text conventions are used in this document:
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Preface

Administering Oracle Data Integrator

Developing Integration Projects with Oracle Data Integrator
Installing and Configuring Oracle Data Integrator

Upgrading Oracle Data Integrator

Application Adapters Guide for Oracle Data Integrator
Developing Knowledge Modules with Oracle Data Integrator

Connectivity and Knowledge Modules Guide for Oracle Data Integrator
Developer's Guide

Migrating From Oracle Warehouse Builder to Oracle Data Integrator
Oracle Data Integrator Tools Reference

Data Services Java API Reference for Oracle Data Integrator

Open Tools Java API Reference for Oracle Data Integrator

Java API Reference for Oracle Data Integrator

Getting Started with SAP ABAP ERP Adapter for Oracle Data Integrator User's
Guide

Oracle Data Integrator 12c Online Help, which is available in ODI Studio through
the JDeveloper Help Center when you press F1 or from the main menu by
selecting Help, and then Search or Table of Contents.

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated

with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for

which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code

in examples, text that appears on the screen, or text that you enter.




Overview of Oracle Data Integrator SAP
BW Knowledge Modules

This chapter provides an overview of Oracle Data Integrator SAP BW Knowledge
Modules.

1.1 Overview

The Oracle Data Integrator SAP BW Knowledge Modules provide integration from
SAP BW systems using SAP JCo libraries. This set of KMs has the following features:

ORACLE

Reads SAP data from SAP BW system
Loads this SAP data into Oracle / non-Oracle Staging Area

Reverse-engineers metadata of warehouse and proposes a tree browser to pick
up only the required metadata

This adapter includes two knowledge modules:

RKM SAP BW: Its main role is to perform customized reverse-engineering of SAP
BW data targets into ODI datastores (Models). The SAP BW RKM is in charge of
connecting to the SAP BW System, which provides the SAP BW data target's
metadata information, and transforming and writing the resulting metadata into
Oracle Data Integrator's repository.

The LKM SAP BW to Oracle (SQLLDR)/LKM SAP BW to SQL connects to SAP
BW and retrieves data targets defined in the SAP Model. It is used in the
mappings. The LKM is in charge of loading source data from a SAP BW System to
an Oracle/non-Oracle staging area.
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Setting Up the Environment

This chapter describes how to set up your SAP BW environment for use with Oracle
Data Integrator.
This chapter includes the following sections:

2.1 Before You Begin

Before you begin, consider the following:

2.1.1 System Requirements and Certification

Before performing any installation you should read the system requirements and
certification documentation to ensure that your environment meets the minimum
installation requirements for the products you are installing.

The Oracle Data Integrator requirements are listed in Installing and Configuring Oracle
Data Integrator.

The requirements specific to the Oracle Data Integrator SAP ABAP - BW Adapter are:

ORACLE

Oracle Data Integrator 11.1.1.7.0 or above.

A Java Connector (JCo) version compatible with adapter must be used. The list of
supported JCo versions is available in the Compatibility Matrix available from My
Oracle Support. A minimum version of JCo 3.0.2 is required.

A JVM version compatible with both Oracle Data Integrator and JCo must be used.
A minimum version of JVM 1.5 is required due to JCo pre-requisites.

The connector supports two transfer modes for transferring data from SAP system
to the ODI agent: data transfer using a Shared Directory and data transfer through
FTP. For details and restrictions see File Transfer Considerations of Application
Adapters Guide for Oracle Data Integrator. Depending on the chosen file transfer
mode the following requirements must be met:

— Data transfer through a Shared Directory (recommended transfer
method) The LKM SAP BW to Oracle (SQLLDR) requires a folder that is
shared between the SAP system and the ODI agent. The SAP application
server transfers the data by writing it out into a folder that is accessible from
the SAP system and the ODI agent machine. This is typically done by sharing
a folder of the ODI agent machine with the SAP system. Note that the shared
folder does not necessarily have to be located on the ODI agent machine. A
shared folder on a third machine is also possible, as long as the shared folder
is accessible to both the ODI agent machine and the SAP system.

2-1


https://support.oracle.com/
https://support.oracle.com/

Chapter 2
Before You Begin

# Note:

For security reasons, the SAP folders should not be shared with the
ODI agent. Share only folders of the ODI agent machine with the SAP
system.

The shared folder must be accessible to SAP system and not just to the
underlying operating system. This means that the folder needs to be declared
in SAP transaction AL11 and the folder opens successfully in AL11.

— Data transfer through FTP LKM SAP BW to Oracle (SQLLDR) requires a
FTP server to upload data from the SAP BW system. This data is either read
locally by the agent executing the mapping (when this agent runs on the FTP
server machine), or remotely (when this agent is located on a different
machine than the FTP server). This FTP server must be accessible over the
network from both the SAP BW machine and the agent machine.

e For LKM SAP BW to Oracle (SQLLDR) only: SQLLoader is required on the
machine running the agent. SQLLoader is used for loading data extracted from
SAP BW system to the Oracle staging area.

2.1.2 Requesting ODI SAP Component Installation into the SAP

System

The ODI SAP adapter communicates with the SAP System using a few ODI SAP
RFCs. These RFCs are installed by your SAP Basis team using SAP Transport
requests. Please contact your SAP administrators for installing the ODI SAP
Components and assigning the required SAP user authorizations by following the
instructions given in the Installing ODI SAP Components section in Application
Adapters Guide for Oracle Data Integrator.

2.1.3 Requesting FTP Server Access

ORACLE

This section applies only if you plan to transfer data using FTP. You can skip this
section if you use a Shared Directory for the data transfer or if your SAP system is
older than the following:

e SAP ECC6 EHP6 or later
e SAP BW/BI 7.4 or later

The following steps must be performed before any subsequent steps in this guide can
be performed. These steps are typically performed by your SAP Basis team. Failure to
perform these setup instructions will lead to FTP failure when running any ODI SAP
extraction jobs.

To request FTP server access:
1. Login to SAP server.

2. Execute transaction SE16.

3. Enter SAPFTP_SERVERS in the Table Name field and click [ icon to create entries.
4. Enter IP address of the FTP server in the FTP_SERVER_NAME field.
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5.

6.

Chapter 2
Validating the Shared Folder Setup

Enter port of the FTP server in the FTP_Server_Port field.

Click icon to save.

2.1.4 Gathering SAP Connection Information

In order to connect to the SAP BW system, you must request the following information
from your SAP administrators:

SAP BW System IP Address or Hosthame: IP address/ Hostname is the
technical name given to the host on which SAP is running.

SAP User: SAP User is the unique user name given to a user for logging on the
SAP BW System.

SAP Password: Case-sensitive password used by the user to log in.

SAP Language: Code of the language used when logging in For example: EN for
English, DE for German.

SAP Client Number: The three-digit number assigned to the self-contained unit
which is called Client in SAP. A Client can be a training, development, testing or
production client or represent different divisions in a large company.

SAP System Number: The two-digit number assigned to a SAP instance which is
also called Web Application Server or WAS.

SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

SAP Transport Layer Name: This string uniquely identifies a transport layer in a
SAP landscape. It allows ODI to create transport requests for later deployment in
SAP. Even though there is a default value here, this transport layer name must be
provided by your SAP Basis team. Not doing so may result in significant delays
during installation.

SAP BW Version: BW 3.5 or Bl 7.0.

SAP Character Set: The character set is only required if your SAP system is not a
UNICODE system. For a complete list of character sets, see "Locale Data" in the
Oracle Database Globalization Support Guide. For example, EE8I S08859P2 for
Croatian Data. For UNICODE systems, use UTF8.

# Note:

All the connection data listed above (except SAP SNC Connection Properties
and SAP Router String) are mandatory and should be requested from the SAP
Administrators. You may consider requesting support during connection setup
from your SAP administrators.

2.2 Validating the Shared Folder Setup

Validating a shared folder setup applies only if you plan to transfer data using a
Shared Directory. This section can be skipped, if the FTP transfer is used. The
validation of the shared folder setup needs to be performed before any subsequent

ORACLE
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steps in this guide can be performed. This validation is typically performed by your
SAP Basis team.

Step 1: Validating folder access from the SAP application server

Start the SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction AL11.

Select the shared folder.

g H @0 b P

Double-click the shared folder to test the directory declaration.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

" Note:

SAP uses the OS user <sid>adm to connect to the directories declared in
AL11.

6. Print screen.

Step 2: Validating folder access from the ODI agent machine

1. Log in to the ODI agent machine using the Windows user ID used for executing
the ODI agent.

2. Open shared directory path in Windows Explorer.

This should list the content of the shared folder. Please make sure that you do
NOT need to enter any credentials. If this does not work or you had to enter
credentials, please contact your windows administrator or the system administrator
of the system your shared folder is physically located on. Do not continue until this
test passes.

3. Print screen.

2.3 Validating the FTP Setup

ORACLE

Validating an FTP setup applies only, if you plan to transfer data using FTP. This
section can be skipped, if you use a Shared Directory for the data transfer. The
validation of the FTP setup needs to be performed before any subsequent steps in this
guide can be performed. This validation is typically performed by your SAP Basis
team.

Step 1: Validating SAPFTPA destination

Start the SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SM59.

Expand TCP/IP connections.

Open the SAPFTPA destination.

g H @ b P
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6. Click Testconnection.

This should report a successful connection. If not, please contact your SAP basis
team. Do not continue until this test passes.

7. Print screen.

Step 2: Testing FTP connection

Go to transaction SE38.

View the function module RSFTP002.

Hit F8 to run the ABAP program.

Enter the FTP userID and password.

Enter the FTP server host name or IP address.
Enter cd / or cd <ODI target directory>.

In the RFC_DESTINATION field, enter SAPFTPA.
Hit F8 to run the test.

@ N O g 0w bR

This should report a successful connection. The message should be similar to the
following:

250 CWD successful.

If this test is not successful, please contact your SAP basis team. Do not continue
until this test passes.

9. Print screen.

2.4 Validating SAP Privileges

ORACLE

This section describes how to test some of the key SAP privileges. Proceed with the
subsequent steps in this guide only after successful validation of these tests. This
validation is typically performed by your SAP Basis team.

Perform the following steps to validate whether a SAP user has appropriate dev rights
and owns a dev license key:

Start SAPGUI.

Use the ODI SAP user and password to connect to the SAP system and client.
Go to transaction SE38.

Enter any sample program name like ZSAP_TEST in the program name field.
Click Create.

g M w b P

6. Perform similar tests for the transaction SE37 and SE11.

If a transaction allows the creation of a program without asking for any key or other
authorization message, then the SAP user has validated that it has the appropriate
dev rights and license key. Otherwise your SAP basis team needs to register the SAP
user in service.sap.com to get the license key and a Basis person can help him with
dev rights.
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2.5 Validating SAP Transport Layer Name

As the SAP connector creates SAP objects, such as, for example, function modules,
into the SAP development system, these changes need to be transported into QA and
production systems once the development is done. The SAP's change and transport
system uses the SAP Transport Layer Name to identify the route a change has to
take. A transport layer is assigned to each development class and thus to all objects in
that class. The transport layer determines:

* In which SAP System developments or changes to the repository objects are
made

» If objects are transported to other systems within the group when development
work has been completed

A consolidation route is created from the development system to the quality assurance
system through the transport |ayer Z<SID>. It then becomes the standard transport
layer for customer development and customizing.

A consolidation route is created from the development system to the quality assurance
system through the transport |ayer SAP for the transport of SAP Standard objects.

It is important to specify the correct transport layer name before running the RKM SAP
BW for the first time. Perform the following steps to identify the list of defined transport
layers in your SAP landscape:

1. Log onin client 000 in the SAP System serving as the transport domain controller
via transaction STMS.

2. Select Overview > Transport Routes. The Display Transport Routes dialog is
displayed.

Select Goto > Graphical Editor.
To switch the mode, select Configuration > Display <-> Change.

Position the cursor on the SAP System.

o o p W

Select Edit > System > Change. The Change System Attriburtes dialog is
displayed.

7. Select the StandardTransport Layer tab.
8. Change the transport layer of the SAP System.
9. The result is the list of the different transport Layers.

By default, the RKM option SAP_TRANSPORT_LAYER_NAME is set to SAP. Ask your
SAP basis admin which transport layer you should use. This transport layer name
must be set on the SAP_TRANSPORT_LAYER_NAME RKM option. A wrong or
invalid transport layer name will cause serious delays during the installation process.

2.6 Installing Oracle Data Integrator

Before starting with this project, you need to install and configure Oracle Data
Integrator. See the Data Integrator Getting Started and the Installing and Configuring
Oracle Data Integrator for more information.
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2.7 Installing and Configuring the Oracle DB Target

ORACLE

This project uses an Oracle database engine as the target and as the staging area for
the mappings. You can download for example an Oracle XE database from the Oracle
Technology Network (OTN). Install and configure this database.

This project targets an Oracle table that can be created using the following script:

-- Create denmp target schema

CREATE USER ODI _SAP_DEMO | DENTI FI ED BY ODI _SAP_DEMO DEFAULT TABLESPACE USERS
TEMPORARY TABLESPACE TENP,
GRANT CONNECT, RESOURCE TO CDI _SAP_DEMO,

-- Create denmp target tables
-- For ODS/DSO

CREATE TABLE ODI_SAP_DEMD. W PURCH DS (
PO_GUI D VARCHAR2( 100) ,

ORDER | TEM GUI D VARCHAR2( 100) ,
ACC_ASS_GUI D VARCHAR2( 100) ,

GUI DE_CONTRCT VARCHARZ( 100) ,

ORDER QUANT NUNBER,

NET PRI CE NUVBER,

PRI CE_UNI T CHAR(5),

NO_OF _PURCH ODR NUMBER) ;

ALTER TABLE ODI_SAP_DEMOD. W PURCH DS ADD CONSTRAI NT PK W PURCH DS PRI MARY KEY
(POGUID);

-- For I NFO OBJECT

CREATE TABLE ODI_SAP_DEMD. W ACCNT VENDR DS (
VENDOR CHAR( 10) ,

PCOVPANY CHAR(10),

PHONE CHAR( 20),

PLANT CHAR(10),

STREET VARCHAR(50),
MED_DESC VARCHAR( 100));

ALTER TABLE ODI_SAP_DEMD. W ACCNT VENDR DS ADD CONSTRAI NT PK W ACCNT VENDR DS PRI MARY
KEY (VENDOR) ;

-- For INFO OBJECT H ERARCHY

CREATE TABLE ODI_SAP_DEMO. W GL_ACCOUNT HI ER DS (
H ER_NAVE CHAR(50),

NODEI D NUVBER( 20) ,

| NFOOBJECT NAME CHAR(80),

NODENAME CHAR(80)

TLEVEL NUMBER(5),

PARENTI D NUVBER( 20) ,

CHI LDI D NUMBER( 20) , NEXTI D NUVBER( 20) ) ;

ALTER TABLE ODI_SAP_DEMD. W GL_ACCOUNT H ER DS ADD CONSTRAI NT PK W GL_ACCOUNT H ER DS
PRI MARY KEY (H ER NAVE, NODEID);

-- For INFO OBJECT I NTERVAL H ERARCHY
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CREATE TABLE TARGET | NTERVAL_HI ERARCHY
(

RSHI ENM VARCHAR2( 30 BYTE)
NODEI D NUMBER(8)

PARENTI D NUVBER( 8)

| NTERVL VARCHARZ(1 BYTE)
LEAFFROM VARCHAR2( 60 BYTE)
LEAFTO VARCHAR2(60 BYTE),
VERS| ON VARCHAR2(3 BYTE),
CHRT_ACCTS VARCHAR2(4 BYTE),
GL_ACCOUNT VARCHAR2(10 BYTE),
BAL_FLAG VARCHARZ(1 BYTE),
GLACCEXT VARCHAR2(18 BYTE),

| NCST_FLAG VARCHAR?(2 BYTE)

)

- For I'NFO CUBE

CREATE TABLE ODI _SAP_DEMD. W VENDR BAL_DS (
QCOMP_CODE CHAR( 6) ,

OCREDI TOR CHAR( 10),

ORC_ACCOUNT CHAR( 10),

TOT_DEBT_POST NUMVBER

TOT_CR_POST NUMBER,

CUMULATI VE_BAL NUVBER) ;

ALTER TABLE ODI _SAP_DEMO W VENDR BAL_DS ADD CONSTRAI NT PK_W VENDR BAL_DS PRI MARY KEY
( OCOVP_CODE) ;

- For I NFO CUBE & I NFO OBJECT Join

CREATE TABLE ODI_SAP_DEMD. W VENDER CUBE_OBJ DS (
COVP_CODE CHAR(10),

VENDOR CHAR( 10) ,

GL_ACCOUNT CHAR( 10),

SALES FOR PERI OD NUMBER

CUM BALANCE NUMBER,

PLANT CHAR(10),

VEDI UM DESC VARCHAR?(100)) ;

ALTER TABLE ODI _SAP_DEMD. W VENDER CUBE_OBJ_DS ADD CONSTRAI NT PK_W VENDER CUBE_OBJ DS
PRI MARY KEY ( COMP_CODE)

CREATE TABLE " TARGET_NAVI GATI ONAL_ATTRI BUTES"

(

| OPK_CUSTOMER VARCHAR(10 BYTE),
| OPKCUST_GROUPVARCHAR2( 2 BYTE)

| OPKPK_CUSTOVERVARCHAR2( 10 BYTE),
| OPK_PK_PLANT VARCHAR2(4 BYTE),

| OPKCALMONTH NUNBER( 6) ,
| OPK_CALVEEK NUNMBER(6),
| OPKTHI P_POl NTVARCHARY(
REQUI DVARCHAR2( 30 BYTE),
KF_ODEL_VOL NUMBER(17, 3),
KF_OSHI PDATE NUMBER(17)
KF_OLOADDATEK NUMBER(17),
KF_QACT_G _DTKNUMBER(17),
KF_OVATAV_DATKNUMBER( 17)

4 BYTE),
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KF_OLATE_QTY NUMBER(17, 3),
CUSTOVERVARCHAR?( 10 BYTE),
PLANT VARCHARZ(4 BYTE),
PHONE VARCHARZ( 16 BYTE),
PCOVPANYVARCHAR? (6 BYTE) ,
OUTL_TYPEVARCHAR2(4 BYTE),
NI ELSEN_| D VARCHAR2(2 BYTE),
LOGSYSVARCHAR2( 10 BYTE),

VI SI T_RYTVARCHAR2(4 BYTE),
USAGE_| NDVARCHAR?( 3 BYTE),
SRCI D VARCHAR?(4 BYTE),
PREC! S| DNUVBER( 4) ,
POSTCD_BOX VARCHAR2(10 BYTE),
CUS_F_CONS VARCHAR2(1 BYTE),
COUNTRYVARCHAR?( 3 BYTE)
BPARTNERVARCHAR?( 10 BYTE),
ACONT_GRPVARCHAR2(4 BYTE),
LANGU VARCHAR?(1 BYTE),
KEYACCOUNT VARCHAR2(1 BYTE)

)

- For OPEN HUB DESTI NATI ON

CREATE TABLE ODI _SAP_DEMD. W OPENHUB_SALES DS (
OHREQUI D NUMBER,

DATA_PACKAGE NUMBER

DATA RECORD NUMBER,

CUSTOMER CHAR(1),

MATERI AL CHAR(1),

MATERI AL_PRI CE NUMBER,

CURRENCY NUMBER,

QUANTI TY NUMBER,

TOTAL_REVENUE NUMBER) ;

ALTER TABLE ODI _SAP_DEMD. W OPENHUB_SALES DS ADD CONSTRAI NT PK_W OPENHUB_SALES DS
PRI MARY KEY (OHREQUI D)

2.8 Installing and Configuring JCo

The SAP adapter uses Java Connector (JCo) to connect to the SAP system. JCo must
be configured before proceeding with the project.

To install and configure JCo:

1. Download a supported JCo version for your configuration from http://
service.sap.com/connectors. Check the supported JCo version in the Certification
Matrix available at My Oracle Support. Note that a minimum version of JCo 3.0.2
is required.
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# Note:

e Choose the SAP JCo package matching your operating system and
your system architecture (32/64Bit). E.g. if you are running ODI inside
a 32-Bit JVM, you must download the 32-Bit SAP JCo, even if the CPU
and OS are 64-Bit. Mixing 32-bit and 64-bit architecture is not possible
due to native libraries required by SAP JCo and will result in
connection failure.

e odi.conf contains the JDK path used for ODI Studio.

Unzip the appropriate distribution package into an arbitrary directory <sapj co-
install-path>.

Follow the installation instructions in <sapj co-i nstal | - pat h>/ j avadoc/
installation.htnl for the respective platform.

Copy sapj co3.jar and sapj co3.dl | :

For ODI 10g: Copy sapj co3.j ar and sapj co3.dl | (or respective binary like
| i bsapj co3. so) into the oracl edi / dri vers directory.

For ODI 11g: Copy sapj co3.j ar and sapj co3.dl | (or respective binary like

| i bsapj co3. so) into the <ODI _HOME>/ odi _ni sc directory (ODI Studio) and into the
<ODI _HOVE>/ or acl edi / agent / dri ver s directory (Standalone Agent) and into the
<WLS_DOMAIN>/lib directory (JEE Agent).

For ODI 12c: Copy sapj co3. jar and sapj co3. dl | (or respective binary like
| i bsapj co3. so) into the <ODI _HOME>/ odi / sdk/ | i b directory (ODI Studio, ODI
Standalone Agent) and into the <WLS_DOMAIN>/lib directory (JEE Agent).

Restart ODI Studio and any agents.

Check the JCo installation. This will be also checked later in this guide.

2.9 Configuring Oracle Data Integrator

Perform the following steps to configure Oracle Data Integrator:

2.9.1 Add the Open Tool

The complete process of installing and adding an Open Tool to ODI is described in
Oracle Data Integrator Tools Reference. This section details only the SAP ABAP
specific steps.

ORACLE

1.
2.
3.

Connect to Designer.
Select ODI > Add/Remove Open Tools...

In the Add/remove Open Tools window, enter the following name in the Open Tool
class name field: or acl e. odi . sap. km _Qdi SapAbapExecut eSt oppabl e.

Click Add Open Tool.

The Open Tool appears as shown below.
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-

o Add Opén Tools [=]

To add an OpenTool, please add your OpenTool's JAR or ZIP files to '<ide,user. dir > foracledijuserib’ folder, then restart Oracle
Data Integrator. Please find <ide.user.dir> property in Properties tab of Help|About section.

| 4 @

% _0disAPAbapExecute "-UPLOAD =<upload option>" "-EXECUTE=<execute option:> 'Emerwider Orade.

This Open Tool will upload an ABAP program and also Extracts the data from SAP Systems, Version  10.1.3.16
To delete this Open Tool, dlick Delete. Delete
Help oK | Cancel
4
6. Click OK.
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This chapter describes how to configure the topology by using a practical example.
This project demonstrates how to extract data from the SAP BW data targets listed
below:

ODS/DSO:

Source data target 0BBP_PO from SAP BW is the ODS containing vendor
information.

Target W_PURCH_DS is a table in an Oracle database that needs to be loaded
from the SAP BW Sources. This table contains purchase order info.

Info Object:

Source data target OCREDITOR is the Info object from SAP BW containing
Account number of supplier/vendor.

Target W_ACCNT_VENDR_DS is a table in an Oracle database that needs to be
loaded from the SAP BW Sources. This table contains account number info of
supplier/vendor.

Info Object Hierarchy:

Source data target 0GL_ACCOUNT is the Info object from SAP BW containing
General Ledger Information.

Target W_GL_ACCOUNT_HIER_DS is a table in an Oracle database that needs
to be loaded from the SAP BW Sources. This table contains account number info
of supplier/vendor.

Info Cube:

Source data target OFIAP_C20 is the Info cube from SAP BW containing vendor
balances.

Target W_VENDR_BAL_DS is a table in an Oracle database that needs to be
loaded from the SAP BW Sources. This table contains vendor balances.

Info Cube & related Info Objects:

Source data targets OFIAP_C20 and OCREDITOR are the Info Cube & Info Object
respectively both containing the vendor related information.

Target W_VENDER_CUBE_OBJ_DS is a table in an Oracle database that needs
to be loaded from the SAP BW Sources as per join condition.

Open Hub:

Source data target ZOHD_SALE is an Open Hub destination name and its
associated table is /BIC/OHZOHD_SALE which contains the sales information.

Target W_OPENHUB_SALES_DS is a table in an Oracle database that needs to
be loaded from the SAP BW Sources. This table contains sales information.

Delta Extraction:
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For delta Extraction you need to pass the value for two KM options i.e.
FIRST_REQ_ID and LAST_REQ_ID from any above said data targets except Info
Object after full load. The FIRST_REQ_ID is the start point of Delta Extraction and
LAST_REQ_ID is the end point of Delta Extraction.

This chapter includes the following sections:

3.1 Configuring the File Server for SAP ABAP

Perform the following operations after installing or upgrading your Oracle Data
Integrator version:

1.
2.

Connect to Topology Manager.

If this SAP ABAP technology does not exist in your Master Repository, import the
SAP ABAP technology in Synonym INSERT_UPDATE mode from the /i npexp
folder.

Perform an upgrade of the Master Repository. Refer to the Installing and
Configuring Oracle Data Integrator for more information on the Master Repository
upgrade process.

In Topology Manager, open the JavaBeanShell technology and check on the
Language tab that the JYTHON language is listed. If not, add it.

Create a File data server pointing to an existing FTP/file server into which the
extraction file will be pushed from SAP and picked up for SQL*Loader. For use
with FTP transfer, set the following parameters. For use with shared folder
transfer, the settings on the data server do not matter.

* Host (Data Server): FTP server IP host name or IP address.
* User: Username to log into FTP server.
* Password: Password for the user.

For use with "LKM SAP BW to SQL" these additional parameters must be
configured:

» JDBC driver class: com.sunopsis.jdbc.driver.file.FileDriver
* JDBC URL: jdbc:snps:dbfile?ENCODING=UTF8

The above URL is for SAP UNICODE systems. For non-UNICODE systems,
please see details on ENCODING parameter in Creating a File Data Server of
Connectivity and Knowledge Modules Guide for Oracle Data Integrator
Developer's Guide. The encoding chosen on this URL must match the code
page used by the SAP Application Server.

In this File data server create a Physical Schema representing the folder in the File
server to which the extraction file will be pushed. For use with FTP transfer, see
details below. For use with shared folder transfer and for more details, see
Transfer using a Shared Directory (recommended) of Application Adapters Guide
for Oracle Data Integrator:

- Data Schema: Path on the FTP server to upload or download extraction files
from the remote location. This path is used when uploading extraction files
from the SAP BW system into the FTP server. It is also used by a remote
agent to download the extraction files. Note that this path must use slashes
and must end with a slash character.
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*  Work Schema: Local path on the FTP server's machine. This path is used by
an agent installed on this machine to access the extraction files without
passing via the FTP server. This access method is used if the
FTP_TRANSFER_METHOD parameter of the LKM SAP BW to Oracle
(SQLLDR)/ LKM SAP BW to SQL is set to NONE. As Work Schema is an OS
file name, slashes/ backslashes should be used according to OS.

Path names given on Data and Work schemas are not necessarily the same:
the FTP service may provide access to a FTP directory named / sapfi | es while
the files can be stored locally in c: \'i net pub\ft proot\ sapfil es.

Refer to File Transfer Considerations of Application Adapters Guide for Oracle
Data Integrator.

8. If the corresponding Logical Schema called File Server for SAP ABAP does not
exist yet, create it. This Logical Schema name is fixed and must be mapped to the
Physical Schema created in the previous step.

3.2 Configuring the Target Data Server

This section describes how to setup an Oracle Data Server. Please use respective
settings when configuring a non-Oracle Target Data Server for use with LKM SAP BW
to SQL.

1. Connectto Topology Manager.

2. In the Physical Architecture tree view, expand the Technologies node and select
the Oracl e technology.

3. Right-click and select New Data Server.

4. Enter the data server Definition as shown below:

) ORACLE TARGET

Tesk Connection

Definition

1oRC Ij Data Server
On Conneck/Disconnect Mame; |0R.C\CLE_TARGET
Propetties
. Technology:
Datasources
Yersion Instance [ dblink (Data Server): |XE
Privieges Connection
Flexfields
User: |OD1_3AP_DEMO
PaSSWDrd: LIIITIT I L)

[] INDI Comnection

Array Fetch Size: Batch Update Size:

5. Select the JDBC tab, and enter the JDBC connection information to your data
server as shown below:
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™) ORACLE TARGET

Test Connection

Definition

IDBC 0BT Driver: |oracle jdbc, OracleDriver

0n ConneckfDisconneck jdbcioracle: thini@localhosk: 1521 XE
Properties IDBC Lrl:

Dakasources

Make sure to change the URL to match your Oracle instance configuration.
Click Test Connection to test the connection to this data server.

From the File menu, click Save.

Right-click the data server you created and select New Physical Schema.

In the Physical Schema windows that appears, select the 0Dl _SAP_DEMO for both
Schema and Work Schema.

If you already have a Work Schema for ODI defined for this data server, you can
use it instead of the ODI _SAP_DEMO Schema.

10. Go to the Context tab.

11. Click Add and enter in the Logical Schema field the value ODI _SAP_DEMO.

12. From the File menu, click Save.

3.3 Configuring the SAP Source Server

The following topics describe how to configure the SAP source server:

3.3.1 Configuring the Data Server

Except for the data server name, all the parameters that you provide while defining the
SAP Data server should be provided by the SAP Administrators. See Gathering SAP
Connection Informationfor more information about these parameters.

ORACLE

1.

In the Physical Architecture tree view, expand the Technologies node, select the
SAP ABAP technology.

Right-click and select New Data Server.

Enter the data server definition. Set the parameters for this data server as follows:
* Name: SAP_BW The name of the data server as it will appear in ODI.

* Host (Data Server): SAP BW System IP Address or Hostname.

e User: SAP User, as provided by the SAP Administrator.

e Password: This user's SAP Password. This password is case-sensitive.

Set the Flexfield values for this data server in the Flexfields tab:

* SAP Language: Code of the language used when logging in. For example EN
for English, DE for German.
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SAP Client Number: The three-digit number assigned to the self-contained
unit which is called Client in SAP. A Client can be a training, development,
testing or production client or represent different divisions in a large company.

SAP System Number: The two-digit number assigned to a SAP instance
which is also called Web Application Server or WAS.

SAP System ID: The three-character, unique identifier of a SAP system in a
landscape.

SAP Character Set: The character set is only required if your SAP system is
not a UNICODE system. For a complete list of character sets, see "Locale
Data" in the Oracle Database Globalization Support Guide. For example,
EE8I S8859P2 for Croatian Data. For UNICODE systems, use UTF8.

# Note:

This FlexField is only used with "LKM SAP BW to Oracle (SQLLDR)".
For use with "LKM SAP BW to SQL" please define the character set
using the ENCODING parameter in the file driver URL, as described in
Configuring the File Server for SAP ABAPfor non-UNICODE SAP
systems.

SAP BW Version: Enter the SAP BW Version as follows:

For SAP BW 7.0 and higher systems enter 700

For SAP BI 3.5 systems enter 350

SAP ERP Version & SAP ABAP Version: unused in SAP BW Connector.

From the File menu, click Save.

# Note:

The Test Connection button for validating SAP Connection definition is not
supported for this connection.

3.3.2 Configuring the Logical Schema

In the Physical Schema window, do not edit the Definition tab.

ORACLE

Select the Context tab, click Add and enter the Logical Schema name

LOG CAL_SAP_BW

B sap_Bw_Default

Definition
Context
Yersian Conkexk Loqical Schema
- Development OEICAL_SAP_EW
Privileges
Flexfields

3-5



Chapter 3
Configuring the SAP Source Server

3. From the File menu, click Save.
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Creating a New Project

This chapter describes how to create a new Project for SAP.

In order to work with the data servers you have created, you must create a project and
import the appropriate knowledge modules for reverse-engineering the data structures

and integrating the data.

4.1 Creating a New Project

ORACLE

To create a new Project for SAP BW:

Connect to Designer.

In the Projects tree view click New Project.

In the Definition tab, enter SAP BW Deno for the Project name.
From the File menu, click Save to save your project.
Expand the SAP Denp Project, select the First Fol der node.
Rename this folder to SDE_BW Dat aTar get s.

Right-click the SAP Denp Proj ect in the Projects tree view.

Right-click and select Import Knowledge Modules.

© ® N o 0 p W Db P

Select in the File import directory the directory containing your BW KMs. By
default, they are located in the .. /i npexp directory.

=
o

. Select the following KMs:
* |KM Oracle Incremental Update
* LKM SAP BW to Oracle (SQLLDR)
e LKM SAP BW to SQL
* RKM SAP BW
* RKM SAP ERP Connection Test
11. Click OK to perform the import.
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This chapter describes how to reverse-engineer the Oracle target and SAP source

data models.

This chapter includes the following sections:

5.1 Reverse-Engineering the Oracle Target

To reverse-engineer the Oracle data model:

1. Connect to Designer.

2. In the Models tree view, click New Model.

3. In the Definition tab, enter the model parameters as shown below:

[ Oracle Target

@ Reverse Enginesr %

Definition
Reverse Engineer
Control
Journalizing
Journalized Tables
Services

Matkers

Memo

Version

Privileges
Flesxfields

Generate and deploy

Model
Mame: ZIZIr'-an:IEe Target
Code: ORACLE_TARGET
Technology: | Oracle

Logical Schema: |ODI_SAP_DEMO

Action Group: | ZGeneric Ackion =

Default Folder: |

Descripkion:

4. Inthe Reverse Engineer tab, select the Global context.

ORACLE

5-1



Oracle Targek
f@ Reverse Enginesr | %

Definition

Heverse Engineer
Selective Reverse-Engineering
Conkral

Journalizing
Journalized Tables
Services

Markers

Memao

Wersion

Privileges

Flexfields

Chapter 5
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Generate and deploy

(#) Standard] () Custamized

Conkext: | Global

Logical Agent: ILu:u:aI (Mo Agenk)

Types of objects to reverse-engineer

Table Yigw Queue [ | Syster Table [ ] Table Alias

[] Synonym

o

Mask:

Characters to Remove From Table Alias: ‘W

Table Alias maximum length: ‘35

5. Click Reverse Engineer, then from the File menu, click Save.

6. The W PURCH DS, W ACCNT_VENDR DS, W GL_ACCOUNT_H ER DS, W VENDR BAL_DS,
W VENDER_CUBE_OBJ_DS, W OPENHUB_SALES DS, W DELTA DS datastore appear in your
Oracle_Target model, as shown below.

-4, 5 ORDERSO3
# | [ ORDERS03 TARGET

BB

[T W_ACCNT_VENDR_DS
+- [ W_DELTA_DS
+ [ w_GED_DS
+ [ W_GL_ACCOUNT_HIER DS
+- [ 2] W _OPENHUB_SALES_DS
& [T W_PURCH_DS
+- [T W_VENDER_CUBE_OB]_DS
[ w_VENDR_BAL DS
+ Hidden Datastores
- CAASAl FRFORCF VR

5.2 Reverse-Engineering the SAP BW Source Datastores

To reverse-engineer the SAP BW Source data targets you need to perform the

following tasks:

1. Creating the Data Model

2. Validating the SAP Connection

3. Starting the Reverse-Engineering Process

This section also includes the following topics:

ORACLE
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5.2.1 Creating the Data Model

N

Ll

In the Models tree view, click New Model.

In the Definition tab, select SAP ABAP technology and the Logical Schema
previously created (in our example it is the LOG CAL_SAP_BW Logi cal Schema ).

In the Reverse Engineer tab:
a. Select Cust oni zed option.
b. Selectthe d obal context.

c. Select the RKM SAP Connection Test you have imported in the SAP BW Deno
project.

5.2.2 Validating the SAP Connection

ORACLE

In the Models tree view, open the SAP BW Sour ce Model.

Click Reverse Engineer and confirm the start of the reverse-engineering process.
This process runs two tests:

- Establish a test connection to the SAP BW system and
» Validate the proper setup of SAP JCo by displaying the About dialog.

In a few seconds, you should see the SAP JCo-About dialog as shown here:
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SAP Java Connector (JCo) |:||i[z|

THE BEST-RUN E-BUSINESSES RUN SAP W

SAP Java Connector (JCo)
Copyright (c) 2000-2007 SAP AG. All rights reserved.
Java Runtime

Operating System: Windows XP 5.1 for x86
Java VM: 1.6.0_14 Sun Microsystems Inc.

Java Codepage: Cp1252

Versions

JCo AP 3.0.2 (2008-03-29)

JCo middleware name: eI

JCo middleware: 11

JCo middleware native: GRERCE

Paths

JCo classes: CAProgram%20Files\Oracleloracledi_10135Noracledivdriversi\sapjco3 jar

JCo library: CAProgram Files\Oracle\oracledi_101351oracleditdriversisapjco3.dll

Please verify the JCo version number (see System Requirements and
Certificationfor more details) and verify that a path for the JCo Library is given
(.dl'l for Windows). If this is not the case or you see any error message in this
about dialog, please review the SAP JCo installation, as described in your SAP
JCo package, and run this test again.

# Note:

Closing the JCo-About-Dialog will also close ODI.

4. Once you have validated SAP JCo installation, open ODI Operator.
5. In the Operator, expand the Reverse-Engineering session down to the task level.

6. Verify whether the task "Test SAP Connection" has been executed successfully. If
not, view the task details to identify the connection problem. The output of this task
must contain Successful |y connected to SAP System If not, the connection test has
failed and the connection problem must be analyzed before you continue.

Do not continue until you have successfully validated the SAP connection!
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# Note:

If you want to validate the SAP connectivity independent of ODI, please see
SAP Stand-Alone Connection Test.

5.2.3 Starting the Reverse-Engineering Process

To start the reverse-engineering process of the SAP BW datastores:

ORACLE

1.

2.
3.

N o a »

In the Models tree view, open the SAP BW Sour ce Model.

In the Reverse Engineer tab:

a.
b.

C.

Select the Cust oni zed option.

Select the @ obal context.

Select the RKM SAP BWyou have imported in the SAP BW Denp project.
Set the USE_GU KMoption to Yes.

For first time RKM use only: Set SAP_TRANSPORT_LAYER NAME to the name of the
transport layer your SAP basis admin has provided you with.

Caution:

e Pay particular attention to provide the correct value for the
SAP_TRANSPORT_LAYER NAME option. If an invalid value is used during
the first time installation, a significant delay in the connector
installation may be caused.

e For first time RKM use only: If you are using a custom value for KM
options SAP_FUNCTI ON_GROUP_ODI _DEV and
SAP_FUNCTI ON_GROUP_ODI _PROD, these function groups must not exist
prior the first execution of the UPLOAD ABAP_CODE and
UPLOAD_ABAP_BASE set to tr ue.

e For first time RKM use only: If you are using a custom value for KM
options SAP_PACKAGE_NAME_CDI _DEV and SAP_PACKAGE_NAMVE_CDI _PROD,
these packages must not exist prior the first execution of the
UPLOAD_ABAP_CCDE and UPLOAD ABAP_BASE set to tr ue.

For first time RKM use only: Set UPLOAD_ABAP_CODE and UPLOAD ABAP_BASE to
true. After the first execution these values must be set back to False.

Set other parameters according to your SAP configuration. See the Application
Adapters Guide for Oracle Data Integrator for more information on the RKM
options.

From the File menu, click Save to save your changes.

Click Reverse Engineer to start the reverse-engineering process.
Click OK.

The Sessions Started Dialog is displayed.
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8. Click OK.
9. Set UPLOAD ABAP_CODE and UPLOAD ABAP_BASE back to No.

10. For first time RKM use only: Validate in Operator that the session is now in status
running. If session has failed, please validate settings. Do not move on until all
installation steps have been completed successfully.

5.2.4 Using the SAP Metadata Browser

As you have set the USE_GUI option to Yes, the RKM displays in the SAP BW
Metadata Browser the SAP objects organized in the tree view as shown below.

" Note:

In case that the below dialog does not show up, see ODI Operator and ODI
Logs for details.

Refer to Log Files in Application Adapters Guide for Oracle Data Integrator for
more details.
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[£x S4P B Meta Data Browser

(= [&] =]

Search

Marme:

Descrigption:

Data Target: % InfoCube 7 InfoChject " ODSIDSO " CpenHub

Lookup Zearch
L SAP BV Metadata
B FE Infodreas
[ [ Infodkjects
& 18 ODSDS0
[k 1] OpenHub
Cancel Reverse

5.2.4.1 The Tree View

The SAP BW Data targets are organized into a tree view. Only the SAP BW Data
targets available in the SAP BW system are displayed. By expanding the tree view,

you can see Info Cubes, Info Objects, ODS/DSO, Open Hub, and select those that you
want to reverse-engineer.

Note that only the data targets selected in the tree view are reverse-engineered.
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E=nE=n )

Search
Mlarme:
De=crigtion:
Data Target: ™ InfoCube " Infodkbject " ODSDS0 " OpenHub
Lookugp Search
_| OCa Crozz-Application Componerts
_| OCRM Customer Relationzhip Management
= | OFMCO Financial Management & Controlling
Y 0PSM Public Sector Management
#1000 Contraling
24 OF) Financial Accounting
= £21| OFIN_REF_SIMPL_1_EHP3 Fepoarting Financialz (EhP3)
25| OFIN_REF_SIMPL_1_EHF3_COOMOPL, Crwerhead Cost Orders

=1 _| InfoCube
[ oF1ap_csi1
- [ oFlaP_R20
&[0 oF1ap_Rs0
- [ OFlap_Rs1
- [0 OF1ap_mz0
- [ OFIP_hs0
[0 OF1ap_ms
- [ OF18P_c30
[ OF1ap_R30
- [ OF1aP_m30
=[] oFlap_c20
: |I| Dimenzions

o B8 ocian -~

i OFIN_REP_SIMPL_1_EHP3_COPC
25| OFIN_REP_SIMPL_1_EHPS_FIGL

5| OFIN_REP_SIMPL_1_FHPS_COOMCCA,
= i3 OFIN_REP_SIMPL_1_EHF3_FI&P

Product Cost Contralling
General Ledger Accounting
Cost Center Accounting
Accounts Payvable Accounting

Check Register: Line
Yendor Balances (Dir
Check Regizter (Dire
Check Register: Line
Wendor Balances
Check Regizter
Check Regizter: Line
Wendors: Line ftem [
Wendors: Line tem [
Wendors: Line tems
Yendor Balances (Rep

m Key Figures

1 [T = VORI T |

5.2.4.2 The Search Panel

Cancel Rewverze

The Search option group allows you search specific objects in the browser, based on:

* Info Cube Name
* Info Object Name
+ ODS/DSO

e Open Hub

For the example project for Info Cube, the data target OFIAP_C20 is used:

ORACLE
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1. Enter OFI AP_C20 in the Name field.
2. Select the InfoCube data target.

3. Click Search to find the object to reverse-engineer. The results are highlighted in
the tree view.

4. Click Reverse.

5. Oracle Data Integrator starts the reverse-engineering process on the selected data
target. The reverse-engineered data targets appear under the Model.

6. Perform steps 1 to 5 to reverse-engineer the following objects:
a. InfoCube 0SD 04
b. InfoObject 0SOLD TO
c. InfoObject 0CREDI TOR
d. InfoObject 0GL_ACCOUNT
e. ODS/DSO 0BBP_PO
f.  Open Hub destination ZOHD_SALE (/ Bl ¢/ OHZOHD_SALE)

5.2.5 Reverse-Engineering Without GUI

ORACLE

If you want to perform a reverse-engineering without using the SAP BW Metadata
Browser, you set the corresponding parameters in the SAP BW KM . For example, for
Info Cube, enter the following parameters in the SAP BW KM options:

- USE_GUI: No
«  INFOCUBE_NAME : OFI AP_C20

With this configuration, the Info Cube data target will be reverse-engineered without
displaying the SAP BW Metadata Browser.

By using the appropriate KM options, you can also select a filter for the reversed data
targets based on for example an Info object, or a ODS/DSO, or an Open Hub table.

Refer to the Application Adapters Guide for Oracle Data Integrator for more
information on the RKM options.

# Note:

It is not possible to view the data in the SAP BW data targets from Oracle Data
Integrator.

What happens when you reverse-engineer SAP BW data targets?

First, Oracle Data Integrator uploads ABAP code in the SAP BW system allowing for
retrieving the SAP BW data targets metadata. This RFC is uploaded only if the
UPLOAD_ABAP_CODE and UPLOAD_ABAP_BASE options are selected (this option is typically
activated only once). The ABAP programs are generated in the SAP function group
given in the SAP_FUNCTI ON_GROUP_ODI _DEV and SAP_FUNCTI ON_GROUP_ODI _PRCD RKM
options.
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Once this code is set up on SAP BW, Oracle Data Integrator is able to retrieve the
SAP BW metadata and to display it in the SAP BW Metadata Browser. Selected
metadata is then reverse-engineered from SAP BW into the Oracle Data Integrator
repository. The repository only contains the description of the SAP BW metadata, and
no data at all.

In addition to the data targets definitions organized and enriched with user-friendly
information, the keys definitions are also retrieved. The model appearing in Oracle
Data Integrator shows all the information required for performing integration tasks on
the SAP BW Model.
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Creating and Running the Mapping

This chapter describes how to create and run the mapping.
This chapter includes the following sections:

6.1 Creating the Mapping

Now that the ODI source and target data models have been created, it is possible to
create the ODI mappings to extract data from the following SAP BW data targets:

e The Info Cube OFI AP_C20 data target to W VENDR BAL_DS Oracle table.
* The Info Object 0CREDI TOR data target to W ACCNT_VENDR DS Oracle table.

e The Hierarchy data from Info Object 0GL_ACCOUNT to W GL_ACCOUNT_HI ER DS Oracle
table.

* The Interval Hierarchy data from InfoObject 0G._ACCOUNT to
TARGET_| NTERVAL_H ERARCHY Oracle table.

 The ODS/DSO 0BBP_PO data target to W PURCH DS Oracle table.

e The Info Cube 0FI AP_C20 and Info Object 0CREDI TOR data targets join to
W VENDER _CUBE_CBJ_DS Oracle table.

* The InfoCube and Navigation Attribute data from I C 0SD_C04 / 10 0SOLD_TOto
TARGET_NAVI GATI ONAL_ATTRI BUTES Oracle table.

*  The Open Hub destination ZOHD _SALE (/ Bl ¢/ OHZOHD SALE) to W OPENHUB_SALES DS
Oracle table.

« Delta Extraction can be done on any above said data targets except Info Object.
How to perform delta extraction is described in Creating a Package for Delta
Extraction .

To create the mapping, perform the following steps:

6.1.1 Info Cube Extraction

This section describes how to create a mapping in ODI in order to load data from the
SAP BW source model representing the InfoCube 0FI AP_C20 data target to the
W VENDR _BAL_DS Oracle target model.

6.1.1.1 Create the Mapping

To create the mapping:

1. Open Designer.

2. Inthe Projects tree view, expand the SAP BW Demo Project.
3. Expand the SAP_BW Dat aTar get s folder.
4

Select the Mappings node.
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Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oCube_SAP_BW Vendor Bal . W VENDR BAL_DS.

From the File menu, click Save to save your mapping.

6.1.1.2 Define the Source and Target Datastores

To define the source and target datastores:

1. Inthe Models tree view, select the W VENDR BAL_DS datastore from the
Oracl e_Target Model.

2. Drag this datastore into the Target Datastore area of the Logical diagram (right
area of the Logical diagram).

3. Inthe Models tree view, select the OFI AP_C20 Vendor Bal ances datastore from the
SAP BW Sour ce model.

4. Drag this datastore into the Sources area of the Logical diagram (left area of the
Logical diagram).

6.1.1.3 Create the Mappings

To create the mappings of the target datastore:

1.
2.

Select the 0COVP_CODE attribute from the target datastore.

Drag the | OPK_OFI AP_C201_0COMP_CCDE_PK_COMP_CCDE attribute from the OFI AP_C20
Vendor Bal ances source datastore onto the COMP_CODE attribute of the target
datastore.

Make sure that the Execute on Hint is set to Source. The mapping should look as
shown below:

COMP_CODE - Properties

Q, Find

=] Target

Expression:

Execute on Hink:

4,

ORACLE

OFIAP_C20.I0PK_OFIAP CZ01_OCOMP_CODE_PK_COMP_CODE

| Source = |

Fixed Execution Locatian: | - |:

Technical Description: | |:

Repeat this operation to perform the following simple mappings:
*  WVENDR BAL_DS. OCREDI TOR = OFI AP_C20. | OPK_OFI AP_C202_OCREDI TOR_PK_VENDOR

¢ WVENDR BAL_DS. ORC ACCOUNT =
OFI AP_C20. | OPK_OFI AP_C202_ORC_ACCOUNT_PK_GL_ACCOUNT

e WVENDR BAL_DS. TOTAL DEBI T PCSTI NG = OFI AP_C20. KF_ODEBI T
e WVENDR BAL_DS. TOTAL CREDI T POSTING - OFI AP_C20. KF_ODEBI T
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e WVENDR BAL_DS. CUMULATI VE BALANCE - OFI AP_C20. KF_0BALANCE

6.1.1.4 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

T TARGET_GROUP
¥ SOURCE_GROUP (8  ODI_SAP_DEMO_UNIT
% LOGICAL_SAF_BW_Ut
En =
i et et
AFIAP_C2C W _WVENMDR_BAL_DS
AFIAP_C20

2. Inthe target group, select the access point for the source group that contains Info
Cube OFI AP_C20 data target. This source group represents the source dataset
made up of SAP Bwdata target.

3. Inthe Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ from the Loading Knowledge Module drop-
down list.

4. Inthe target group, select the target Oracle database, which is also used as the
staging area for this mapping.

5. Inthe Property panel, under Integration Knowledge Module, select | KM Oracl e
Increnental Update from the Integration Knowledge Module drop-down list.

6. Setthe IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

7. From the File menu, click Save and close your mapping.

6.1.2 Info Object Extraction

This section describes how to create a mapping in ODI in order to load data from a SAP
Bwsource model representing the Info Object 0CREDI TOR data target to the
W ACCNT_VENDR_DS Oracle target model.

6.1.2.1 Create the Mapping

1. Open Designer.

2. Inthe Projects tree view, expand the SAP BW Deno Project.
3. Expand the SAP_BW Dat aTar get s folder.
4

Select the Mappings node.
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Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oQbj ect _SAP_BW Vendor Acc. W ACCNT_VENDR DS.

From the File menu, click Save to save your mapping.

6.1.2.2 Define the Source and Target Datastores

To define the source and target datastores:

1.

In the Models tree view, select the W ACCNT_VENDR_DS datastore from the
Oracl e_Target Model.

Drag this datastore into the Target Datastore area of the Logical diagram (right
area of the Logical diagram).

In the Models tree view, select the Info Object's main table 0CREDI TOR Vendor
datastore from the SAP BWSource model.

Drag this datastore into the Sources area of the Logical diagram (left area of the
Logical diagram).

Perform the same operation for the Info Object text table TXT_OCREDI TOR Texts:
Char. Vendor datastore from the SAP BWSource model.

6.1.2.3 Define Joins between Info Object's Main table and Text Table

To create joins between the source datastores of Info Object's main table and text
table in the mapping:

ORACLE

1.

In the Logical diagram when you drag the Info Object's text table TXT_0CREDI TCR
Texts: Char. Vendor the join will be automatically created on attribute vendor from
the OCREDI TCR Vendor Info object's main table datastore and the Vendor attribute of
Info Object's text table TXT_OCREDI TOR Texts: Char. Vendor. This defines the first
join on the vendor Key identifier, as shown below:
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OCREDITOR
EMDOR
PCOMPANY
PHONE
PLANT
POBOX
POBO¥_LOC
POSTAL_CD
POSTCD_BOX
POSTCD_GIS
PRECISID
REGION
SORTL

SRCID
STREET
TAX_NUMB
TAX_NUMB2
TRZONE
UNLD_PT_WE
NAME3
ACCNT GRPV

h

JOIM

h

B @
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T¥T_0CREDITOR
WEMDOR
TATHD

2. In the Properties panel, select Joi n Order and make sure that the Execute on Hint
option is set to Source as shown below:
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JOIN - Propetties
Q, Find
= Condition
OCREDITOR. VENDOE. = TXT OCREDITOR.VEHDOR
Jnin Candition:
Cross Mlatural
OCREDITOR(OCREDITOR) [ ] [] TET_0CREDITOR(TAT_OCREDL. ..
Jaoin Type:
4 Inner Join

All roves paired by the join condition between OCRECITOR{OCREDITOR) and THT_OCREDITOR{TRT _OCREDITOR)

Technical Descripkion: |

Generate ANSI Syntax: [

Join Crder: User Defined: |10
Execute on Hink: lNu:u hink
General
Connector Points Staging
Target
3. Make sure that table number of main table 0CREDI TOR is smaller than that of text
table TXT_OCREDI TQR. In 1:n relationships the parent table has to be the first in a
join.
4. Change join type to left outer join (All rows from 0CREDI TOR and matching ones from
TXT_OCREDI TOR.
6.1.2.4 Create the Mappings

To create the mappings of the target datastore:

1. Select the VENDCR attribute from the target datastore.

2. Drag the VENDCR attribute from the OCREDI TOR source data target onto the VENDOR
attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:
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YEMDOR - Properties

Q, Find 2
= Targek
OCREDITOR. VENDOE
Expression:
Execute an Hink: |5|:|ur|:e
Fixed Execution Location: |

4. Repeat this operation to perform the following simple mappings:
e WACCNT_VENDR_DS. PCOVPANY = OCREDI TOR. PCOVPANY
*  WACCNT_VENDR _DS. PHONE = OCREDI TOR. PHONE
e WACCNT_VENDR_DS. PLANT = OCREDI TOR. PLANT
e WACCNT_VENDR DS. STREET = QCREDI TOR. STREET
o WACCNT VENDR DS. MED DESC = TXT_OCREDI TOR. TXTMD

6.1.2.5 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

" SOURCE_GROUP

<= LOGICAL_SAP_BW_UNIT

TXT_OCREDITOR

= TARGET_GROUP

- ® ODI_SAP_DEMO_UNIT

F?IJ

e

JOIN JOIN_AP W_ACCHNT_VENDR_DS

L

ACREDITOR

2. In the target group, select the access point for the source group that contains both
the Info Object's main table 0CREDI TOR and text table TXT_OCREDI TOR. This source
group represents the source dataset made up of Info Object's main table & text
table joined SAP Bwdata targets.

3. Inthe Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ from the Loading Knowledge Module drop-
down list.
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In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under the Integration Knowledge Module, select | KM Oracl e
I ncremental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.1.3 Info Object Hierarchy Extraction

This section describes how to create a mapping in ODI in order to load data from a
SAP BW source model representing the hierarchy data for Info Object 0GL_ACCOUNT
data target to the W GL_ACCOUNT_HI ER DS Oracle target model.

6.1.3.1 Create the Mapping

7.

© g p W Db P

Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oObj ect _SAP_BW G Account . W GL_ACCOUNT_HI ER_DS.

From the File menu, click Save to save your mapping.

6.1.3.2 Define the Source and Target Datastores

To define the source and target datastores:

ORACLE

1.

In the Models tree view, select the W GL_ACCOUNT_DS datastore from the
Oracl e_Target Model.

Drag this datastore into the target area of the Logical diagram (right area of the
Logical diagram).

In the Models tree view, select the Info Object's hierarchy table H ER_0G._ACCOUNT
datastore from the SAP BWSource model.

Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

Add the following filter condition on the RSHIENM source attribute:
H ER_OG._ACCQOUNT. RSHHI ENM = ' ACI 1'

Please note that ACl 1 is the name of a hierarchy defined for 0GL_ACCOUNT. A list of
defined hierarchies is available under Description section of the Definition tab
when opening the hierarchy data store.

After adding the filter condition the Sources diagram should look as shown below:
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] HER_0GL_ACCOUNT

B RSHIENM =

@  HED

O=  NODED
I0BJHM « s =
NODEMAME —
TLEVEL
LINK
PARENTID
CHILDID
NEXTID

6.1.3.3 Create the Mappings

To create the mappings of the target datastore:

1. Select the H ER_NAME attribute from the target datastore.

2. Drag the RSH ENMattribute from the H ER_0GL_ACCOUNT source data target onto the
HIER_NAME attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

HIER_MAME - Properties

Q, Find F)
=] Target
HIFR. 0GL ACCOUHT . RSHTEHM
Expressian:
Execuke on Hint: | Source
Eivvnd Cacmmt bimm | membices |

4. Repeat this operation to perform the following simple mappings:
e WG._ACCOUNT HI ER DS. NODEI D = HI ER_OGL_ACOOUNT. NODEI D
o WGL_ACCOUNT_H ER DS. | NFOOBJECT NAME = HI ER 0GL_ACCOUNT. | OBJNM
e WG._ACCOUNT_HI ER_DS. NODENAME = HI ER_OGL_ACOOUNT. NODENANE
e WGL _ACCOUNT H ER DS. TLEVEL = H ER 0GL_ACCOUNT. TLEVEL
*  WG._ACCOUNT_HI ER DS. PARENTI D = HI ER_OGL_ACCOUNT. PARENTI D
e WGL ACCOUNT H ER DS. CHI LDI D = HI ER 0GL_ACCOUNT. CHI LDI D
e WG._ACCOUNT_HI ER DS. NEXTI D = HI ER_0GL_ACCOUNT. NEXTI D

6.1.3.4 Define the Mapping Flow

To define the mapping flow:
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Select the Physical diagram. The Flow diagram looks as shown below:

OO SOURCE_GROUP o TARGET_GROUP
% L OGICAL_SAP_BW_UI ® ODI_SAP_DEMO_UNIT
= = =
—_—
HIER_DGL_ACCOUNT HIER_0GL_ W_GL_ACCOUNT_HER_DS

In the target group, select the access point for the source group that contains both
the Info Object's main table 0CREDI TOR and text table TXT_OCREDI TOR. This source
group represents the source dataset made up of Info Object's main table & text
table joined SAP Bwdata targets.

In the Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ from the Loading Knowledge Module drop-
down list.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM O acl e
Incremental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.1.4 Info Object Interval Hierarchy Extraction

This section describes how to extract data from InfoObject and InfoObject hierarchy
table containing an interval hierarchy. The data is extracted from InfoObject
0GL_ACCOUNT and InfoObject hierarchy table H ER_0G._ACCOUNT.

6.1.4.1 Create the Mapping

ORACLE
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Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oQbj ect _I nf oObj ect Hi erar chy_j oi n. 0GL_ACCOUNT.

From the File menu, click Save to save your mapping.
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6.1.4.2 Define the Source and Target Datastores

To define the source and target datastores:

1.

In the Models tree view, select the TARGET | NTERVAL_HI ERARCHY datastore from the
Oracle_Target Mbdel W SD_DELI VERY_CUBE_SOLDTO.

Drag this datastore into the target area of the Logical diagram (right area of the
Logical diagram).

In the Models tree view, select the InfoObject 0G._ACCOUNT from the SAP BW
source model.

Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

Perform the same operation for the InfoObject hierarchy table H ER_0G._ACCOUNT
datastore from the SAP BW Source model.

6.1.4.3 Define Joins between Sources (Info Object Main table and InfoObject
Hierarchy Table)

The join between InfoObject and InfoObject Hierarchy table may automatically be
added by ODI. - There may be situations when more than one join shows up. E.g.
when the same InfoObject is referenced more than once in different characteristics.
Such unwanted extra joins have to be removed.

FILTER - Properties
Q, Find

Apply source-side Filters on RSHIENM and VERSION:

=l Condition

Filker Condition:

Execute an Hink:

Technical Description: | |

FILTER1 - Properties

Q Find

HIER. 0GL ACCOUHT .RSHTEHM = 'EW IFC'

| Source - |

= Condition

Filker Condition:

Technical Description: | |

Execute an Hink:

ORACLE

HIER. 0GL RACCOUNHT . VERSTON = 'L

| Source bl |
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Add joins: all joins must be executed on staging area. Not on source.

The join expression looks like this:

P
Q, Find
Condition (6L, RCCOUNT.CHRT RCCTS || GL_ACCOUNT.GL ACCOUNT) =HIER 0GL ACCOUNT.NODENAME
General Join Condition MIER 0GL ACCOUNT.INTERVL='' (' (GL_ACCOUNT.CHRT ACCTS || GL_RCCOUNT.GL ACC
Connactor Points HETIEE HIER 0GL ACCOUNT . LEAFFROM '/ HIER 0GL RCCOUNT.LERFTO /') HIER O0GL
Cross  Matursl
GL_ACCOUNT(GL_ACCOUNT) [ ] [] HIER_0GL_ACCOUNT(HIER_0...
1ol Tye: Left Outer Join
&l rows of GL_ACCOUNT(GL_ACCOUNT) inchuding the rows unpaired with HIER_0GL_ACCOUNT{HIER_DGL_

Technical Description: |].[Page of Hierarchy bo] AND [HIER._OGL_ACCOUNT Hierarchy: InfoObject GJL Account (HIER_OGL_ACCOUNT

Generate ANST Syntax: [v]

Join Order; I User Defined:

The final join and filter setup should look like this:

1 HER_OGL_ACCOUNT
@~  RSHENM »
@~  HEID -
»
.

@~  NODEID

-

FILTER

- BNCDENANE N 7 o T

Sy M

FILTER1

BAL_FLAG
GLACCEXT
INCST_FLAG
LOGSYS
SEM_POSIT
SOURSYSTEM

O00008

ORACLE"
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6.1.4.4 Create the Mappings

To create the mappings of the target datastore:

1. Drag the NODEI D attribute from the HIER_O0GL_ACCOUNT source data target onto
the NODEID attribute of the TARGET_INTERVAL_HIERARCHY target datastore.

2. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

MODEID - Properties

Q, Find
=] Target
HIER 0GL RCCOUHT . HODETD
Expression:
Execute on Hink: | Source "'|
— [ [ ' [N [ I

3. Repeat this operation to perform the following simple mappings:
*  TARCET_I NTERVAL_HI ERARCHY. RSHI ENM = HI ER_OG._ACCOUNT. RSH ENM
e TARGET_INTERVAL_HIERARCHY.PARENTI D = H ER_OGL_ACCOUNT. PARENTI D
*  TARGET_INTERVAL_HIERARCHY.INTERVL = H ER_OGL_ACCOUNT. | NTERVAL
e TARGET_INTERVAL_HIERARCHY.LEAFFROM = HI ER_OGL_ACCOUNT. LEAFFROM
e  TARGET_INTERVAL_HIERARCHY.LEAFTO = H ER_OGL_ACCOUNT. LEAFTO
e  TARGET_INTERVAL_HIERARCHY.VERSI ON = H ER_OGL_ACCOUNT. VERSI ON
e  TARGET_INTERVAL_HIERARCHY.CHRT_ACCTS
*  TARGET_INTERVAL_HIERARCHY.G._ACCOUNT = OGL_ACCOUNT. GL_ACCOUNT
«  TARGET_INTERVAL_HIERARCHY.BAL_FLAG = OGL._ACCOUNT. BAL_FLAG
*  TARGET_INTERVAL_HIERARCHY.GLACCEXT = OGL_ACCOUNT. GLACCEXT
«  TARGET_INTERVAL_HIERARCHY.I NCST_FLAG = OGL_ACCOUNT. | NCST_FLAG

OGL_ACCOUNT. CHRT_ACCTS

6.1.4.5 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:
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In the target group, select the access point for the ODI Source Group.

In the Property panel, under Loading Knowledge Module, verify that LKM SAP BW t o
Oracle (SQLLDR) or LKM SAP BWto SQL has been set.

In the target group, select the target Oracle datastore, which is also used as the

staging area for this mapping.

In the Property panel, under Integration Knowledge Module, verify that IKM SQL

Control Append has been set.

Execute the Mapping. Verify that data got populated into the target datastore.

6.1.5 ODS/DSO Extraction

This section describes how to create a mapping in ODI in order to load data from a
SAP BW source model representing the 0DS/ DSO 0BBP_PO data target to the W PURCH DS
Oracle target model.

6.1.5.1 Create the Mapping

6.1.5.2 Define the Source and Target Datastores

ORACLE

7.

To define the source and target datastores:

1.

o a0 k 0w b PR

Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.

Expand the SAP_BW Dat aTar get s folder.
Select the Mappings node.
Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:

ODS_SAP_BW Pur chOr dl . W PURCH_DS.

From the File menu, click Save to save your mapping.

In the Models tree view, select the W PURCH DS datastore from the Oracl e_Tar get

Model.

Drag this datastore into the targets area of the Logical diagram (right area of the

Logical diagram).
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3. Inthe Models tree view, select the 0BBP_PO Purchase Order - Single Docunents
datastore from the SAP BWSource model.

4. Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

6.1.5.3 Create the Mappings

To create the mappings of the target datastore:

1. Select the PO QU DE attribute from the target datastore.

2. Drag the BBP_POGUI D attribute from the 0BBP_PO Purchase Order - Single Docunents
source data target onto the PO_GUIDE attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

PoEUID - Properties

Q, Find 2
=] Target
OBEEF_PO.EEP_POGUID
Expression:
Execute on Hink: |S|:|url:e "|
Fixed Execution Location: | v|
Tarhriral Maccvimkinms | |

4. Repeat this operation to perform the following simple mappings:
*  WPURCH_DS. ORDER | TEM GUI D = 0BBP_PO. BBP_PQOl TGU
e WPURCH DS. ACC ASS GUI D = 0BBP PO. BBP_ACGUI D
e W PURCH_DS. GUI DE_CONTRCT = 0BBP_PQ. BBP_CTGUI D
e WPURCH DS. ORDER QUANT = 0BBP_PO. BBP ASPQOU
*  WPURCH DS. NET_PRI CE = OBBP_PO. BBP_NETPRC
e WPURCH DS. PRI CE_UNIT = OBBP_PO. BBP_PRCUNT
e WPURCH DS. NO OF_PURCH CDR = OBBP_PO. BBP_POCT

6.1.5.4 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:
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L5 SOURCE_GROUP s TARGET_GROUP
== LOGICAL_SAP_BWW_LI () ODI_SAP_DEMO_UNIT
| 5 0
—
ABEP_PO ABBP_PO_ W_PURCH_DS_

In the target group, select the access point for the source group that contains
ODS/ DSO 0BBP_PO data targets. This source group represents the source dataset
made up of SAP Bwdata target.

In the Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ from the Loading Knowledge Module drop-
down list.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM O acl e
Increnental Update from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.1.6 Info Cube & Related Info Object Extraction

This section describes how to create a mapping in ODI in order to load data from a
SAP BW source model representing the Info Cube 0FI AP_C20 and Info Object 0CREDI TOR
data targets join to the W VENDER_CUBE_OBJ_DS Oracle target model.

6.1.6.1 Create the Mapping

7.

© o » w dh P

Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oCube_| nf oChj ect _j oi n. W VENDER_CUBE_OBJ_DS.

From the File menu, click Save to save your mapping.

6.1.6.2 Define the Source and Target Datastores

To define the source and target datastores:

ORACLE
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1. Inthe Models tree view, select the W VENDER CUBE_0BJ_DS datastore from the
Oracl e_Target Model.

2. Drag this datastore into the target area of the Logical diagram (right area of the
Logical diagram).

3. Inthe Models tree view, select the Info Cube OFI AP_C20 Vendor Bal ances datastore
from the SAP BwWSource model.

4. Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

5. Perform the same operation for the Info Object's main table 0CREDI TOR Vendor and
text table TXT_OCREDI TOR Texts: Char. Vendor datastore from the SAP BW Sour ce
model.

6.1.6.3 Define Joins between Sources (Info Cube & Object)

To create joins between the source datastores of a mapping:

1. Inthe Sources area of the Logical diagram drag the
| OPK_OFI AP_C202_0CREDI TOR_PK_VENDCR attribute from the Info Cube 0FI AP_C20 Vendor
Bal ances datastore onto the VENDOR attribute in the Info Object's main table
OCREDI TOR Vendor . This defines the first join on the Vendor Key identifier, as shown

below:
= OCREDITOR
@ VENDOR
PCOMPANY &= T¥T_OCREDITOR
PHOME b= WEMDOR
PLAMT = THTND
POBOX
POBOX_LOC
s
)
= OFIAP_C20 o
@~ IOPK_OFIAP_C201_OCOMP_CODE_PK_COMP_CODE
@~  IOPK_OFIAP_C202_OCREDITOR_PK_VENDOR
@~  IOPK_OFIAP_C202_ORC_ACCOUNT PK_GL_ACCOUNT
@~  IOPK_OFIAP_C202_OCHRT ACCTS_PK_CHRT_ACCTS
IOPK_OFIAP_C203_OCURTYPE_PK_CURTYPE
IOPK_OFIAP_C20T_OFISCPER_PK_FISCPER —
IOPK_DFIAP_C20T_OFISCYARNT_PK_FISCYARNT
IOPK_OFIAP_C20T_OFISCYEAR_PK_FISCYEAR
IOPK_OFIAP_C20T_OFISCPER3_PK_FISCPERS3
IOPK_OFIAP_C20U_OCURRENCY _PK_CURRENCY
@~ REQUD

KF_ODEBIT

2. In the Properties panel, you can see the join clause:
OFI AP_C20. | OPK_OFI AP_C202_0CREDI TOR_PK_VENDCR=0CREDI TOR. VENDCR
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3. Inthe Properties panel, select Generate ANSI Syntax and Join Order options,
and make sure that Execute on Hint option is set to Source as shown below:
JOIN - Propetties
Q1 Find
= Condition
OFIAP CZ0,I0PE OFIAP CZ01 OCOMP CODE PE COMP CODE = OCREDITOR. VENI
Join Condition:
Cross Matural
OFLAP_C20{0FIAP_C20) ] [] OCREDITOR(DCREDITOR)
Join Type:
elERRS Inner Jaoin
Al rowes paired by the join condition between OFTAP_CZ0(0FTAP_C20) and OCREDITORQCRED]
Technical Description: |
Generate ANSI Synkax:
Join Order: User Defined: |10
Execute on Hink: |5|:uurce
4. Make sure that table number of OFI AP_C20 is smaller than that of OCREDI TOR. In 1:n
relationships the parent data target has to be the first in a join.
5. Change join between 0FI AP_C20 and 0CREDI TOR to left outer join (All rows from
OFI AP_C20 and matching ones from 0CREDI TOR.
6. Change join between 0CREDI TOR and TXT_OCREDI TOR to left outer join (All rows from
0CREDI TOR and matching ones from TXT_0CREDI TCR.
6.1.6.4 Create the Mappings
To create the mappings of the target datastore:
1. Select the COW_CODE attribute from the target datastore.
2. Drag the | OPK_OFI AP_C201_0COVP_CODE_PK_COMP_CODE attribute from the OFI AP_C20
Vendor Bal ances source data target onto the COW_CODE attribute of the target
datastore.
3. Make sure that the Execute on Hint option is set to Source. The mapping should

ORACLE

look as shown below:
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COMP_CODE - Properties

Q, Find
=] Target
OFIAP C20.I0PE_OFIAP CZ01_OCOMP_CODE_PE COMP_COLE
Expressian:
Execute on Hink: | Source = |
Fixed Execution Location: | v|

4. Repeat this operation to perform the following simple mappings:

« W VENDER CUBE_OBJ_DS. VENDCR =
OFI AP_C20. | OPK_OFI AP_C202_OCREDI TOR_PK_VENDCR

¢ W VENDER CUBE_OBJ_DS. GL_ACCOUNT =
OFI AP_C20. | OPK_OFI AP_C202_ORC_ACCOUNT_PK_GL_ACCOUNT

« W VENDER CUBE_OBJ_DS. SALES FOR PERI OD = OFI AP_C20. KF_0SALES
¢ WVENDER CUBE_OBJ_DS. CUM BALANCE = OFI AP_C20. KF_OBALANCE

« W VENDER CUBE OBJ_DS. PLANT = OCREDI TOR. PLANT

« W VENDER CUBE_OBJ_DS. MEDI UM DESC = TXT_OCREDI TOR TXTMD

6.1.6.5 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

By SOURCE_GROUP
- LOGICAL_SAP_BW_UNIT
— 1" TARGET_GROUP
T¥T_OCREDITOR
: ® ODI_SAP_DEMO_UNIT
B L = |J
e = B
AFIAP_C20 T =
L (B | JOINT_ &P W _WENMDER_CUBE_CBJ_DS_
—
JOIN
ACREDITOR

2. Inthe target group, select the access point for the source group that contains both
the I nfo Cube and Info Object tables. This source group represents the source
dataset made up of two joined SAP Bwdata targets.
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In the Property panel, under Loading Knowledge Module, select LKM SAP BWt o
Oracle (SQLLDR) or LKM SAP BWto SQ from the Loading Knowledge Module drop-
down list.

In the Property panel, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM O acl e
Incremental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.1.7 Info Cube Extraction with Navigational Attributes

This section describes how to create a mapping in ODI in order to load data from a
SAP InfoCube and its navigation attributes. The data is extracted from Info Cube
0SD_004 and InfoObject 0SOLD_TO.

6.1.7.1 Create the Mapping

7.

1
2
3
4.
5
6

Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
I nf oCube_I nf oChj ect _Nav_j oi n. 0SD_C04.

From the File menu, click Save to save your mapping.

6.1.7.2 Define the Source and Target Datastores

ORACLE

To define the source and target datastores:

1.

In the Models tree view, select the 0SD_C04 datastore from the Oracle Target Model
TARGET_NAVI GATI ONAL ATTRI BUTES.

Drag this datastore into the targets area of the Logical diagram (right area of the
Logical diagram).

In the Models tree view, select the Info Cube 0SD C04 Delivery service datastore
from the SAP BWSource model.

Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).

Perform the same operation for the Info Object main table 0SOLD TO Cust oner
dat ast or e from the SAP BWSource model.
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6.1.7.3 Define Joins Between Sources (Info Cube & Info Object)

ORACLE

The join between InfoCube and InfoObject will automatically be added by ODI. - There
may be situations when more than one join shows up. E.g. when the same InfoObject
is referenced more than once in different characteristics. Such unwanted extra joins
have to be removed.

The final join setup with its join expression should look like this:

= 0SD_C04
IOPK_DSD_C041_0SOLD_TO_PK_CUSTOMER &
IOPK_DSD_C041_0SOLD_TO__OBPARTMER_PK_BP.
IOPK_0SD_C041_0CUST_GROUP_PK_CUST_GROUF
IOPK_0SD_C041_0SHIP_TO_PK_CUSTOMER
IOPK_0SD_C042_OPLANT_PK_PLANT
IOPK_DSD_C042_0STOR_LOC_PK_STOR_LOC
IOPK,_DSD_C044_OMATERIAL_PK_MATERIAL
IOPK,_DSD_C047_0SALESORG_PK_SALESORG
IOPK_DSD_CO04T_OCALDAY_PK_DATEO S
IOPK_0SD_CO04T_0CALMONTH_PK_CALMONTH
IOPK_DSD_C04T_OCALWEEK_PK_CALWEEK B
IOPK_0SD_C04T_OFISCPER_PK_FISCPER
IOPK_DSD_CO4T_OFISCVARNT_PK_FISCVARNT
IOPK_0SD_C04U_0VOLUMELNIT_PK_UNIT
IOPK,_0SD_CO4U_DUNIT_OF WT_PK_UNIT
IOPK,_0SD_C04U_OBASE_UOM_PK_UNIT
IOPK_0SD_C04U_OSALES_UNIT_PK_UNIT
IOPK_0SD_C047_ODISTR_CHAN_PK_DISTR_CHAN

THTHETHTH

=

h

JOIM

= 0SOLD_TO

®) O~ CUSTOMER
POBOX =
PLANT
PHONE =
PCOMPANY
OUTL_TYPE
NIELSEN_ID
NAME3
NAMEZ
NAME

| |

All InfoObject joins for retrieving navigation attributes must be executed on *staging*
area. Not on source:
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JOIM - Propetties
Q Find

ad

= Condition

0%D_C04.TOPE 05D CO41 0S0LD TO PE_CUSTOMER = 030LD TO. CUSTOMER
Join Condition:

Craoss Makural
050 _C04{0s0_C04) |:| |:| 0SOLD_To{0S0L0_TO)
Jain Type: :
Inner Jaoin

All roves paired by the join condition bebween 050 _C04(050_C04) and 03OLD_TO(0SOLD_TO)

Technical Description: |

menerate AMST Synta:

Jain Crder: L]
Execuke on Hint: |Staging
6.1.7.4 Create the Mappings

To create the mappings of the target datastore:

1. Drag the 0SD_C04. | OPK_0SD C041_0SOLD TO PK_CUSTOMER attribute from the 0SD_C041
Del i very service Source data target onto the
IOPK_0SD_C041 0CUST_GROUP_PK_CUST_GROUP attribute of the target
datastore.

2. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

IOPKCUST_GROUP_PK_CUST_GROUP - Properties

Q, Find
=] Target
05D _C04.I0PE_03D_CO41 OCUST GROUP_PE_CUST GROUP
Expressian:
Execute on Hink: | Saurce - |
Fixed Execution Location: | v|
AR S S [ I

3. Repeat this operation to perform the following simple mappings:
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TARGET MAWVIGATIONAL ATTRIBUTE - Properties
1, Find
= Aktributes
Attributes: Q
Marne Expression

IOPK_CLSTOMER
IOPK_CALMOMTH
IOPKCALWEEK
IOPK_OSPOINT
RECUID
KF_ODEL_YOL
KF_0SHIPDATE
KF_OLOADDATEK
KF_0ACT_GI_DTK
KF_OMATAY_DATE
KF_OLATE_OTY
CUSTOMER
POEOY

PLANT

PHOME
PCOMPANY
QUTL_TYPE
LAMEL

I0PK,_DSCUSTOMER
IOPKCUST_GROUP_PK_CUST_GROUP

0SD_C04.I0PK_0SD_C041_0SOLD_TO_PK_CUSTOMER
050_C04,I0PK_05D_C041_0CUST_GROUP_PK_CIST_GROUP
050_C04.I0PK_05D_C041_0SHIP_TO_PK_CUSTOMER
0S0_C04,I0PK_05D_C04T_0CALMOMTH_PK_CALMOMTH

05D _C04.I0PK_0SD_C04T_OCALWEEK_PK_CALWEEK
050_C04,I0PK_05D_C042_0SHIP_POINT_PK_SHIP_POINT

050 _C04,REQUID
0SD_C04.KF_ODEL_WOL

05D _C04.KF_OSHIPDATE
050 _C04,KF_OLOADDATEK
050_C04.KF_0ACT_GI_DTE
0SD_C04.KF_OMATAY_DATE
05D _C04.KF_OLATE_QTY
0S0LD_TCLCUSTOMER
0S0LD_TCLPOBOY
0S0OLD_TCLPLANT
050LD_TC.PHOME
0S0OLD_TCLPCOMPANY
050LD_TOLOUTL_TYPE
0S0OLD_TOLLAMGU

6.1.7.5 Define the Mapping Flow

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram appears as follows:

E‘E‘ SOURCE_GROUP EHE TARGET_GROUP
W LOGICAL_SAP_BW_LI @ CDI_SAP_DEMO_LIMIT
i 5

ASOLD_TO ASOLD_TC
Enl =

1
- -

JoIM TARGET_MAWIGATIOMAL _ATTRIBUTE
i e

ASD_C04 ASD_C04_
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In the target group, select the access points for the ODI Source Datastores.

In the Property panel, verify that LKM SAP BWto Oracle (SQLLDR) or LKM SAP BWto
SQ has been set for every ODI Source Datastore.

" Note:

This mapping will generate several SAP ABAP extraction programs. One
for retrieving any display attributes and key figures from the InfoCube and
one for each InfoObject containing navigation attributes.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, verify that IKM SQL
Control Append has been set for the target datastore.

Execute the Mapping. Verify that Info Cube and Navigational attributes got
populated into the target datastore.

6.1.8 Open Hub Extraction

This section describes how to create a mapping in ODI in order to load data from a
SAP BW source model representing the Open Hub destination ZzOHD_SALE (/BI T/
OHZOHD_SALE) to the W OPENHUB_SALES DS Oracle target model.

6.1.8.1 Create the Mapping

7.

o g » 0 b PR

Open Designer.

In the Projects tree view, expand the SAP BW Deno Project.
Expand the SAP_BW Dat aTar get s folder.

Select the Mappings node.

Right-click and select New Mapping.

In the Mapping Definition tab, enter the mapping name:
OpenHub_Sal es. W OPENHUB_SALES DS.

From the File menu, click Save to save your mapping.

6.1.8.2 Define the Source and Target Datastores

ORACLE

To define the source and target datastores:

1.

In the Models tree view, select the W OPENHUB_SALES DS datastore from the
Oracl e_Target Model.

Drag this datastore into the targets area of the Logical diagram (right area of the
Logical diagram).

In the Models tree view, select the ZOHD_SALE datastore from the SAP BW Sour ce
model.

Drag this datastore into the sources area of the Logical diagram (left area of the
Logical diagram).
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6.1.8.3 Create the Mappings

To create the mappings of the target datastore:

1. Select the OHREQUI D attribute from the target datastore.

2. Drag the OHREQUI D attribute from the ZOHD_SALE source data target onto the OHREQUI D
attribute of the target datastore.

3. Make sure that the Execute on Hint option is set to Source. The mapping should
look as shown below:

OHREQUID - Propetties

Q, Find ?
=] Targek
ZOHD SALE . OHREQUID
Expression:
Execute an Hink: |Sn:|urn:e R
g R f I

4. Repeat this operation to perform the following simple mappings:
e WOPENHUB_SALES DS. DATA PACKAGE = ZOHD_SALE. DATAPAKI D
o WOPENHUB SALES DS. DATA RECORD = ZCHD SALE. RECORD
e WOPENHUB_SALES DS. CUSTOMER = ZOHD SALE. D_CUSTOMER
e WOPENHUB_SALES DS. MATERI AL = ZOHD_SALE. D_MATERI AL
e WOPENHUB_SALES DS. MATERI AL_PRI CE = ZOHD SALE. PRI CE_MAT
e WOPENHUB_SALES_DS. CURRENCY = ZOHD_SALE. CURRENCY
o WOPENHUB_SALES DS. QUANTI TY = ZOHD SALE./BI ¢/ ZQTY
°  WOPENHUB_SALES DS. TOTAL_REVENUE = ZOHD_SALE. /Bl C/ ZREV

6.1.8.4 Define the Mapping Flow

ORACLE

To define the mapping flow:

1. Select the Physical diagram. The Flow diagram looks as shown below:

oy TARGET_GROUP
$ 3 50CHCCIOROE (® ODI_SAP_DEMO_UNIT
<= LOGICAL_SAP_BW_LII
i &=
553 ek
ZOHD_SAL W_OPENHUE_SALES DS _
ZOHD_SALE
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In the target group, select the access point for the source group that contains
Open Hub Destination Table ZOHD_SALE. This source group represents the source
dataset made up of SAP BWOpen Hub table.

In the Property panel, under Loading Knowledge Module, select LKM SAP BWto
Oracle (SQLLDR) or LKM SAP BWto SQ from the Loading Knowledge Module drop-
down list.

In the target group, select the target Oracle database, which is also used as the
staging area for this mapping.

In the Property panel, under Integration Knowledge Module, select | KM Or acl e
Incremental Updat e from the Integration Knowledge Module drop-down list.

Set the IKM options as follows:
a. Select No for the FLOW_CONTROL option.
b. Leave other options as they are.

From the File menu, click Save and close your mapping.

6.2 Running the Mapping

This section contains the following topics:

Running the Mapping
Review the Mapping Execution

Review the Resulting Data

6.2.1 Running the Mapping

To run the mapping:

ORACLE
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In the Projects tree view, expand the SAP Deno Project

Expand the SAP_BW Dat aTar get s folder.

Expand the Mappings node.

Select the | nf oCube_SAP_BW Vendor Bal . W VENDR_BAL_DS mapping.
Right-click and select Run.

In the Execution window that appears, click OK.

Click OK in the Session Started window.

What happens when you run the mapping?

First, Oracle Data Integrator creates an ABAP program that does the following:

1.

It performs the extraction of the data on the SAP BW system. In this example, the
extraction will be done on Info Cube source data targets and then returns the
resultset in an extraction file.

It uploads the extraction file into a FTP data server. This FTP host is specified via
the File Logical Schema called File Server for SAP ABAP. This Logical Schema is
mapped to a Physical Schema and therefore a data server in the given context.
This data server contains the connection information for the FTP host.
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Then, the ABAP code is uploaded using the OdiSapAbapExecute tool. The ABAP
program is pushed into the SAP Function group given in the
SAP_FUNCTION_GROUP_NAME LKM option. This phase can be suppressed by
setting the UPLOAD_ABAP_CODE LKM option to No.

The ABAP code is executed also by the OdiSapAbapExecute tool. At the end of the
ABAP code execution, the extraction file is available in the FTP host.

The Oracle Data Integrator agent is able to download this extraction file from the FTP
host, or directly access it, depending on the FTP_TRANSFER_METHOD specified in
the IKM option.

Finally, when the agent accesses the extraction file, it uses SQL*Loader or a JDBC
Connection to load this file into the Oracle/non-Oracle staging area. The rest of the
integration process takes place within the Oracle/non-Oracle engine.

6.2.2 Review the Mapping Execution

To review the mapping execution:

Connect to Operator.
In the Operator, select the Session List tree view.
Expand the All Executions node in this tree view.

The latest session is the first entry of this list.

@ H W d P

Double click the I nf oCube_SAP_BW Vendor Bal . W VENDR_BAL_DS node to see the
session details and the number of lines processed.

6.2.3 Review the Resulting Data

To review the resulting data:

1. In the Designer, in the Models tree view, expand the Oracl e Target Model.

2. Select the W VENDR BAL_DS datastore, right-click and select Data to view the data
integrated into the target Oracle table.

3. Repeat the same steps for remaining mappings:
* I nfoGbject_SAP_BW Vendor Acc. W ACCNT_VENDR DS
o (DS SAP_BW PurchOrdl . WPURCH DS
* InfoCube_I nfoQbject_joi n. WVENDER CUBE_OBJ_DS
e (OpenHub_Sal es. W OPENHUB_SALES_DS
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This chapter describes how to create a package for delta extraction.

So far we have seen examples of extracting data from BW data targets. The
instructions in this chapter explain how the mappings introduced in the previous
chapters can be turned into delta extraction mappings.

In delta extraction mappings only the data, which was changed after last extraction, is
extracted. Delta extraction mappings are only supported for InfoCubes, ODS/DSO and
Open Hub objects, but not for InfoObjects.

This chapter includes the following sections:

Modify the Mapping Flow
Creating the MIN_REQUEST _ID Variable
Creating a Package for Delta Extraction

Running the Package

7.1 Modify the Mapping Flow

The first step is to modify the mapping:

ORACLE
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Select the desired Mappings.

Double click the mapping.

Select the Physical diagram.

In the target group, select the access point for the source group.

In the Property panel, under Loading Knowledge Module, set KM option values for
FIRST_REQ_ID to #M N_REQUEST IDand LAST_REQ_ID to
<@odi SAPBWDel t aRef . get Last Or MaxReql d() @ as shown below.
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Loading Knowledge Module: |LKM SAP BYW to Oracle (SQLLDR)

Shyle: |Temp|ate-sty|e

Options Descripkion

Ciptions:

Iame

----- SAP_TRANSPORT_REQUEST_DESC
----- DATAFILE_PER,_SESSION

----- SAP_REPORT_MAME_PREFTX

----- TRUNCATE_COHD_AFTER_EXTRACTION
----- CHECK_D@TA_FOR_DELIMITERS
----- UPDATE_LAST_REGQID

----- FIRST_REQ_ID

----- LAST_REQ_ID

----- PROCESS_CHAIN

----- FILE_FORMAT

----- FIELD_SEPARATOR.

----- FTP_TRAMSFER_METHOD

----- SOL_BASED_EXTRACTION

----- FTP_PASSIYE_MODE

----- FILE_TRANSFER_TIMECUT

Description

SAP Transpork Request Desc
Allowe per session file name
Prefiz of grouped ABAP Reports
Flag ko indicate ko truncate
Checks delimiter char in data value
Max Request ID Fetch Flag
Skart point of Delta Extraction
End point of Delta Extraction
(Open Hub Process Chain Mame
Delimited Yalue

Colurn Seperator

Data Transfer Method

Twpe of extraction Far Hierarchy
FTP Mode

FTP Time out time

juny
@
T

cpeesee

I

Yalue
ODL: < %=odiRef . getStep{"STEP_MAME")%: >
False

False
True

]
5

-
&
]
o
a,
o
c

#MIN_REGUEST_ID
<@=0diSAPEWDEltaRef, EetLastOrMaxReaE()@>

DELIMITED
“@=""+{char}3@=
FTR

False

True

100000

6. From the File menu, click Save and close your mapping.

7.2 Creating the MIN_ REQUEST ID Variable

The second step consists of creating an ODI variable that stores the last extracted
request ID. This request ID serves as the starting point for the next extraction run:

1. Create a MIN_REQUEST _ID variable to hold the last request id. The

FEREFEEOORERERE

MIN_REQUEST _ID variable has to be a numeric variable with a Keep Hi story or

Last - val ue Action as shown below.

Y MIN_REQUEST_ID

Definition y :
- ¢ Variable [Project: SAP BW Demo]
Refreshing —————————
History Name: MIN_REQUEST_ID
LT Datatype: | Numeric vl
Memo !
Version Keep History: |AII Yalues v
Privileges Secure Value: [ ]
Default Yalue: U
Description:
Start Point of Infocube Delta Extraction
Owerview
—

2. The value of this variable is updated at the end of the delta extraction package
described in the third step. It happens once delta extraction is finished and the
MAX REQUEST ID will be fetched from SAP BW system and will be stored into
the ODI Variable (MIN_REQUEST ID). The refresh expression shown here is
used to update the variable:

ORACLE
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U MIN_ REQUEST_ID

Definition . - —
- Schema: | SUNOPSIS_MEMORY_ENGINE
Refreshing

Histary Select Query: EE} 4 /

Markers Select «@=0diSAPBWDelkaRef .getLastOrMaxReqld()@ >FROM DUAL
Memo

Version

Privileges

Cverview

7.3 Creating a Package for Delta Extraction

In the third step the building blocks created in the previous steps are put together:
Variable and Mappings are arranged into a Package:

1. Open the SAP Deno Project.
2. Create a new Package named SAP Den.
3. Insert a Declare Variable step to this Package:

Drag and Drop the M N_REQUEST_I D variable and select the "Declare Variable" step
type.
4. Insert a Flow step to this Package:

Drag and drop the Mapping created in the previous sections for InfoCube/ ODS or
OpenHub-Extraction in the Package.

5. Insert a Refresh Variable step to this Package.

Drag and Drop the M N_REQUEST_I D variable and select the "Refresh Variable" step
type.

6. Define the step sequence.
a. Define the Declare Variable step as the First Step.
b. Link it to the Flow step that is the next step upon success.

c. Link the Flow step to the Refresh Variable step that is the next step upon
success and the last step in the Package. Add arrows between the variables.

Your Package should look as shown on this screenshot.
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7.4 Running the Package

ORACLE

To run the Package:

Step name Type
MIN_REQUEST_ID | [Refresh variable |
Linked object Path
MIN_REQUEST_ID | [[5ap BW Demo)

* Inthe Projects tree view, expand the SAP Deno Project.

e Select the SAP Deno Package.

* Right-click and select Run.

* In the Execution window, click OK.

* In the Session Started window, click OK.

What happens when you execute the delta extraction Package?

First, Oracle Data Integrator initializes the variable MIN_REQUEST_ID with the last
historized value (declare variable step). This value is then passed into ABAP

extraction program to specify where to start the data extraction. The KM queries the
SAP system for the highest assigned request ID. All data between min and max

request ID will be extracted (mapping).

After the execution of the mapping the refresh variable step stores the highest request
ID into MIN_REQUEST _ID for next extraction run.
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Going Further with Oracle Data Integrator

This chapter describes what steps to take next with Oracle Data Integrator.
You have now completed a Project extracting data from a SAP BW system.

In this Project, you have:

Set up the environment and topology to work with SAP BW.
Created and reverse-engineered a SAP BW data model.

Created different mappings to load the data from Info Cube, Info Object, ODS/
DSO, Info Cube & Info Object join, Open Hub destination table, Delta SAP BW
data targets & tables into the Oracle database.

Refer to individual KM options and their descriptions as well as to Considerations for
SAP BW Integration in Application Adapters Guide for Oracle Data Integrator for more
information on the SAP BW KM features and options.

¢ Note:

In case the execution did not complete successfully, please check the ODI

Operator and ODI Logs for details. In addition to this, the following log files will

contain execution information.

e <System Tenp Dir or local FTP dir>/ ZODI _<Mapping
| d>_<SrcSet >_<Cont ext >. out

e <System Tenp Dir or local FTP dir>/ ZODI _<Mapping
| d>_<SrcSet>_<Context>.err

Refer to Log Files in Application Adapters Guide for Oracle Data Integrator for

more details.

8.1 Going further with Oracle Data Integrator

Use the demonstration environment to familiarize yourself with Oracle Data Integrator.
You can go further with Oracle Data Integrator by taking advantage of the samples
available on the Oracle Technology Network.

ORACLE
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SAP ABAP BW Required Privileges

This appendix lists the required privileges for accessing the SAP system using Oracle
Data Integrator.

For connecting to the SAP system a SAP dialog user is required for RKM installation
and LKM execution during development. A SAP RFC user is not sufficient.

This user has to have a developer license key. License keys can be retrieved from
http://service.sap.com. Any execution attempts without this developer license key will
lead to failure and may cause the need for clean-up operations.

Later for RKM execution and LKM execution in production a SAP RFC user is
sufficient.

These SAP user types can be used for the following operations:

Table A-1 Required SAP User Types
]

Operation Required SAP User Type

RKM: Setup SAP Dialog user

RKM: Reverse Engineering SAP Dialog user or SAP RFC user
LKM: Development SAP Dialog user or SAP RFC user
LKM: Production SAP Dialog user or SAP RFC user
Testing ODI Generated Extraction RFCs SAP Dialog user or SAP RFC user

The following tables list the privileges required for using SAP BW Knowledge Modules:

A.1 Important points to consider

Consider the following points while configuring the SAP privilieges:

e« S_DATASET is an authorization object that controls access to physical file, so you
need to provide access to SAP directories & folder mounted path. The values
provided here are sample paths, you need to provide your landscape directories
path or provide *(all).

* NRor (NR) means NOT REQUIRED.

A.2 Authorizations Required for RKM SAP BW Upload

The following authorizations are required for first time installation of RKM SAP BW.

¢ Note:

Developer Key is required in this authorization.
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Appendix A

Authorizations Required for RKM SAP BW Upload

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S RFC ACTVT 16 a
S RFC RFC_NAME RFCL1, RSAB, RSB3RO, SDI FRUNTI ME, (NR -
SDI FRUNTI ME, SUTL, { RSAB, RSB3RD, SYSU})
SYST, SYsSU, zODI_F&R
S RFC RFC_TYPE FUR
S_TCODE TCD SU53, SE38 e
S ADM _FCD S ADM _FCD MEMO
S CTS_ADM CTS_ADVFCT TABL
S_DATASET ACTVT 34 33
S_DATASET FI LENAMVE D:\usr\sap\trans\actlog \\DELBI 7\ SAPMNT\trans
\ DBT*, \'act | og\ Bl Dz*
\
\ 10. 30. 0. 214\ ODI _SAPTES
T\ ZODI *,
\'\ DELRC6\ sapmt\trans
\act | og\ DBT*
S_DATASET PROGRAM SAPLSTRF
S TABU DI S ACTVT 03
S TABU DS DI CBERCLS MA
S DEVELOP ACTVT 01, 02, 03, 06 07, 16
S_DEVELOP DEVCLAS $TMP, ZODI _LKM PCKG, v
ZODI _RKM PCKG
S DEVELCP OBJNANE Z$$SXRFC, ZODI _FGR,
ZODI _FGR_PROD,
ZODI _LKM PCKG,
ZODl_RKM PCKG
S_DEVELOP OBJTYPE DEVC, FUGR, PROG
S _DEVELCP P_GROUP *
S_TRANSPRT ACTVT 01, 02, 03, 06 06 (NR)
S_TRANSPRT TTYPE DTRA, TASK "
S _RS_ADM/\B ACTVT 03,16
S RS _ADWB RSADMABOBJ | NFOOBJECT
S RS | CUBE ACTVT 03
S_RS_| CUBE RSI CUBEOBJ DATA, DEFINITION "
S_RS_| CUBE RSI NFOAREA NCDESNOTCONNECTED 0*
S RS | CUBE RSI NFOCUBE 0*, z* 1*
S RS | 0BJ ACTVT 03
S RS I OBJ RSI OBJ 0*, z* "
S RS | OBJ RS| OBJCAT * 0*, OCHANOTASSI NED, Z*
S RS |1 0BJ RSI OBJPART DEFI NI TI ON DATA, DEFI NI TI ON
S_RS_ODSO ACTVT 03
S_RS_0DSO RSI NFOAREA 0*, NODESNOTCONNECTED '
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Object Field Name Value (BW 3.5) Value (Bl 7.0)
S_RS_0DSO RSODSOBJ 0*, Z* a
S RS _0DSO RSCDSPART DATA, DEFI NI TI ON

A.3 Authorizations Required for RKM SAP BW Execution

The following authorizations are required for first time installation of RKM SAP BW.

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S RFC ACTVT 16
S RFC RFC_NAME RFC1, RSB3RD,
SDI FRUNTI ME, SYST,
ZODl _FGR
S RFC RFC_TYPE FUGR
S _TCODE TCD SU53
S_TABU DI S ACTVT 03
S TABU DI S DI CBERCLS MA SC
S RS _ADM/AB ACTVT 03, 16 16 NR
S_RS_ADWB RSADMABOBJ | NFOOBJECT
S_RS_| CUBE ACTVT 03
S_RS_ | CUBE RSI CUBEOBJ DATA, DEFI NI TI ON
S_RS_| CUBE RSI NFOAREA NCDESNOTCONNECTED 0*
S RS | CUBE RSI NFOCUBE 0*, z*
S RS I OBJ ACTVT 03
S RS | 0BJ RSI OBJ 0*, z* Z* (NR)
S RS I 0BJ RSI OBJCAT * 0*
S RS |1 0BJ RSI OBJPART DEFI NI TI ON
S _RS_0DSO ACTVT 03
S _RS_0DSO RSI NFOAREA 0*, NODESNOTCONNECTED T+, Z*,
NODESNOTCONNECTED ( NR)
S_RS_0DSO RSODSCBJ 0%, Z* *U
S _RS_0DSO RSCDSPART DATA, DEFI NI TI ON

A.4 Authorizations Required for LKM SAP BW Upload
(Background mode)

The following authorizations are required for running the mappings using SAP BW
LKMs in a SAP development environment when LKM option BACKGROUND_PROCESSI NG is
set to true (recommended default).
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< Note:

Developer Key is required in this authorization.

Appendix A

Authorizations Required for LKM SAP BW Upload (Background mode)

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S RFC ACTVT 16 '
S_RFC RFC_NAME RFC1, SDI FRUNTI ME, (NR : {RSAB, SYSU})
SLST, SYST, ZODI_FQ&R
Z0Dl _FGR_PRCOD*, RSAB, SYS
u
S RFC RFC_TYPE FUR
S _TCODE TCD SE38, SUs3
S_APPL_LOG ACTBT 03, 06 v
S _APPL_LOG ALG_OBJECT ZODI _APPOBJ
S APPL_LOG ALG SUBOBJ ZODI_SUBOBJ
S _BTCH_ADM BTCADM N Y
S _BTCH JOB JOBACTI ON RELE v
S BTCH JOB JOBGROUP
S CTS_ADM CTS_ADVFCT TABL
S_DATASET ACTVT 06, 33, 34 a
S_DATASET FI LENAMVE D:\usr\sap\trans\actlog
\ DBT*,
\
\ 10. 30. 0. 214\ ODI _SAPTES
T\ ZODI *,
D: \ usr\sap\ DBT
\ DVEBMGS40\ wor k\ ZODI *
S_DATASET PROGRAM SAPLSTRF, ZCODI * SAPLSLOG D22, SAPLZQDI *
S DEVELCP ACTVT 01 02, 03, 06, 16
S DEVELOP DEVCLASS
S_DEVELOP CBJNAMVE ZODl _FGR PROD*
S_DEVELOP OBJTYPE FUGR, PROG Y
S_DEVELCP P_GROUP
S _PROGRAM P_ACTI ON NR EDI T, SUBM T, VARI ANT
S_PROGRAM P_GROUP NR
S_TRANSPRT ACTVT 01, 02, 03 03 (NR
S_TRANSPRT TTYPE DTRA, TASK
S RS _AUTH Bl AUTH NR 0*
S_RS | CUBE ACTVT 03, 06 NR
S_RS_| CUBE RSI CUBEOBJ DATA, DEFI NI TI ON NR
S_RS_| CUBE RSI NFOAREA NCDESNOTCONNECTED NR
S RS | CUBE RSI NFOCUBE 0*, z* NR
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A.5 Authorizations Required for LKM SAP BW Execution
(Background mode)

The following authorizations are required for running the mappings using SAP BW
LKMs in a SAP production environment when LKM option BACKGROUND_PRCCESSI NG is set
to true (recommended default).

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S RFC ACTVT 16 :
S_RFC RFC_NAMVE RFCL, SDI FRUNTI ME, SYSU(NR)
SLST, SYST, zODi*, SYSU
S RFC RFC_TYPE FUGR
S _TCODE TCD SU53
S APP_LOG ACTBT 03,06 a
S _APP_LOG ALG_OBJECT ZoDl_*
S APP_LOG ALG SUBOBJ ZoDi _*
S_BTCH_ADM BTCADM N Y
S _BTCH JOB JOBACTI ON RELE v
S BTCH JOB JOBGROUP
S_DATASET ACTVT 06, 33, 34
S_DATASET FI LENAVE D:\usr\sap\trans\actlog
\ DBT*,
\
\ 10. 30. 0. 214\ ODI _SAPTES
T\ ZODl *,
D: \ usr\sap\ DBT
\ DVEBMGS40\ wor k\ ZODI *
S_DATASET PROGRAM 20Dl *
S DEVELCP ACTVT NR 01, 02, 03, 06, 07, 16
S_DEVELOP DEVCLASS NR
S _DEVELCP OBJNANE NR S_TCODE
S DEVELOP OBJTYPE NR SUSO
S_DEVELOP P_GROUP NR .
S _RS_AUTH Bl AUTH AR
S RS | CUBE ACTVT 03
S RS | CUBE RSI CUBECBJ DATA, DEFI NI TI ON
S_RS_| CUBE RSI NFOAREA NODESNOTCONNECTED 0*, Z*, (NR:
{ NCDESNOTCONNECTED} )
S RS | CUBE RSI NFOCUBE 0*, z* "
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Authorizations Required for LKM SAP BW Upload (Dialog mode)

A.6 Authorizations Required for LKM SAP BW Upload

(Dialog mode)

The following authorizations are required for running the mappings using the SAP BW
LKMs in a SAP development environment when LKM option BACKGROUND_PROCESSI NG is
set to fal se (non-default).

" Note:

Developer Key is required in this authorization.

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S RFC ACTVT 16
S_RFC RFC_NAME RFCL, SDI FRUNTI ME, RSAB( NR)
SYST, ZODI _FGR,
ZODI _FGR_PROD*, SYSU, RSA
B
S RFC RFC_TYPE FUGR "
S_TCODE TCD SE38, SE53
S CTS_ADM CTS_ADVFCT TABL
S_DATASET ACTVT 06, 33, 34
S_DATASET FI LENAMVE D:\usr\sap\trans\actlog "'
\ DBT*,
\
\ 10. 30. 0. 214\ ODI _SAPTES
T\ ZODI *,
D: \ usr\sap\ DBT
\ DVEBMGS40\ wor k\ ZODI *
S_DATASET PROGRAM SAPLSLOGF, Y
SAPLSTRF*,
SAPLZODI *
S DEVELCP ACTVT 01, 02, 03, 06 "
S _DEVELCOP DEVCLASS
S DEVELCP OBJNANE ZODI_FGR_PROD*
S _DEVELOP OBJTYPE FUGR, PROG
S_DEVELOP P_GROUP v v
S_PROGRAM P_ACTI ON NR EDIT, SUBM T, VARI ANT
S_PROGRAM P_GROUP AR
S_TRANSPRT ACTVT 01
S_TRANSPRT TTYPE DTRA, TASK Y
S_RS_AUTH Bl AUTH AR 0*
S RS | CUBE ACTVT 03 NR
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Authorizations Required for LKM SAP BW Execution (Dialog mode)

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S_RS_| CUBE RSI CUBECBJ DATA, DEFI NI TI ON NR
S RS | CUBE RSI NFOAREA NODESNOTCONNECTED NR
S RS | CUBE RSI NFOCUBE 0*, z* NR

A.7 Authorizations Required for LKM SAP BW Execution

(Dialog mode)

The following authorizations are required for running the mappings using the SAP BW
LKMs in a SAP production environment when LKM option BACKGROUND_PROCESSI NG is set
to f al se (non-default).

Object Field Name Value (BW 3.5) Value (Bl 7.0)
S RFC ACTVT 16
S RFC RFC_NAME RFC1, SDI FRUNTI ME,
SYST, ZODI _FGR_PROD*
S RFC RFC_TYPE FUGR
S TCODE TCD SUs3
S_DATASET ACTVT 06, 33, 34
S_DATASET FI LENAME \ "
\ 10. 30. 0. 214\ ODI _SAPTES
T ZODI *,
D: \ usr\sap\ DBT
\ DVEBMGS40\ wor k\ ZCDI *
S_DATASET PROGRAM SAPLSLOGF, SAPLSTRF*,
SAPLZODI *
S _RS_AUTH Bl AUTH NR 0*
S RS | CUBE ACTVT 03
S RS | CUBE RSI CUBECB DATA, DEFI NI TI ON DATA (NR)
S_RS_| CUBE RSI NFOAREA NODESNOTCONNECTED NR
S_RS_| CUBE RSI NFOCUBE 0*, Z* NR
S RS | OBJ ACTVT NR 03
S RS | 0BJ RSI OBJ NR
S RS | OBJ RSI OBJCAT NR v
S_RS_ | GBJ RSI OBJPART NR DEFI NI TION
S RS ODSO ACTVT AR 03
S RS_0DSO RSI NFOAREA NR
S_RS_0DSO RSODSCBJ NR t
S_RS_CDSO RSODSPART NR DEFI NI TI ON
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SAP Stand-Alone Connection Test

This appendix describes how to perform an SAP stand-alone connection test.
In addition to the Connection Testing described above, a test can be performed
outside of ODI using a standalone java utility:

B.1 SAP Stand-Alone Connection Test

To use a standalone java utility to test the connection:

1. Open a command window.

2. Change to <ODI _HOME>/ odi / sdk/ | i b directory.

3. Make sure that JAVA_HOME points to a JVM (at least 1.5).
4

Make sure that you have installed SAP Java Connector and that the sapjco3.jar
and the sapjco3 library are in the <ODI _HOME>/ odi / sdk/ | i b directory.

5. Launch the utility using the following command:
On Windows:
java -cp sapjcod.jar;odi-sap.jar oracle.odi.sap.kmtest.JCoTest
On Linux/UNIX:
java -cp sapjcod.jar:odi-sap.jar oracle.odi.sap.kmtest.JCoTest

This should result in an output similar to this:

CATION: Connect t
{SAP Application Se
on local heost th Unicode
Application Eerver?’ unknown
p B8 16:87:27 288

{network interfacel

&Ii‘ﬂul.llurjl_.ﬂq,lH-ﬂ.nu; "{BAF Application Server?’ not Ffound
ddrinfo

6. Use a text editor to open the ODI_SAP_CON_POOL.jcoDestination file in the
oracledi/drivers directory. The file should look like this:

#for tests only

jco.client.|ang=EN
jco.destination.peak_|init=10
jco.client.client=800
jco.client.passwd=<SAP Passwor d>
jco.client.user=<SAP User>
jco.client.sysnr=00

jco.destination.pool _capacity=5
jco.client.ashost=<SAP Application Server>
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7. Enter your SAP connection information, which you have received from your SAP
administrator. The file will then look similar to this (use your connection
information!):

#for tests only !

j co.
j co.
j co.
j co.
j co.
j co.
j co.
j co.

client.lang=EN

destination. peak_|int=10
client.client=800
client.passwd=0Dl 123
client.user=0Dl
client.sysnr=00

desti nati on. pool _capacity=5
client.ashost=123.123.123. 123

8. Launch the utility again using the following command:

On Windows:

java -cp sapjcod.jar;odi-sap.jar oracle.odi.sap.kmtest.JCoTest

On Linux/UNIX:

java -cp sapjcod.jar:odi-sap.jar oracle.odi.sap.kmtest.JCoTest

This should result in an output similar to this:

WINDOWS' system 32\ cmd.exe
SYSTEH CALL getaddrinfo
o

COUNTER

OWN_CODEPAGE:
_CHARSEI =

OWUN_REL:
PARTNER_REL:
NER_TYPE:

0ODI_SAP_CON_POOL

D:~0ralHome_1%oracledisdrivers?

In addition to just testing the SAP connection, the utility will also validate the
existence of certain Function Modules required for the RKM. These are installed
during first execution of the RKM (UPLCAD_ABAP_CODE and UPLOAD ABAP_BASE set to
true).

ORACLE

B-2



Appendix B
SAP Stand-Alone Connection Test

9. Delete the ODI _SAP_CON POOL. j coDesti nati on file after execution, as it contains the
SAP login credentials.
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